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This document is intended to provide the reader with information related to PRO-CHEX Standard,
Optional and upgrade features available through PRO-CHEX Enterprise. These features are
differentiated in this document as follows:

» Standard features will appear in regular font, as shown here.

» Optional features will appear in green, italic font, as shown here.

If you see a feature within this documentation that is not currently enabled for your organization, contact
us at [FI INSERT PHONE NUMBER] for assistance.

NOTICE:

This document contains confidential proprietary information published by ACH Alert, an Alkami
Solutions Team. The information in this document is intended solely for the use of ACH Alert’s
employees and clients.

All rights reserved. This information may not be disclosed to any third party without the express
written permission of ACH Alert, an Alkami Solutions Team.

NOTE:

» All screenshots used in this User Guide were obtained while using PRO-CHEX in the
Chrome browser. If a Client user utilizes PRO-CHEX in a different browser, certain
screens may display differently than what is seen in this guide because of the browser’s
particular configuration. However, even though screens may appear slightly different, the
functionality will remain the same across all browsers.

NOTE:

» As of 08/20/2021, the FPHQ platform and all modules thereon are supported for the
following modern browsers only:

Chrome: Last 4 versions
Firefox: Last 4 versions
Firefox Extended

Support Release: Latest

Edge: Last 4 versions

ACHALE Jesion 207 1.

Page 2 of 132
an Alkami Solution Team



Table of Contents

L. WELCOME TO PRO-CHEX! ... .ottt e et e et ettt ettt e e ekt e oottt e e ekt e e et et e e ekt e e ameeeeaneeeeneeeeneeeanneeans 5
AL SEIVICE OVEIVIEW .....eiiieiiieii ittt e e e ettt e e e s s s et e e et e e s 4 s o R e et e e e e e e s o R R e e ee e e e e e e e o s s s r e e n e e e e e e s s e nmrn e e neees 5
B. Introduction to PRO-CHEX .......ccoiiiiiiiiiiiiii ettt 5

II. PRO-CHEX DASHBOARD BOX ... ..ottt e ettt e e ettt e e oo ekttt e et e e ekttt e e e anae e e e e e nbe e e e e amneeeeeaas 11
A, Using the Dashboard..............ooo 11
B.  Creating ClIENT USEIS .....coiiiiiiiiiiiiii ettt ettt ettt e e e e e e e e e 13

lll. USER ACCOUNTS AND PRIVILEGES............ooiiiitiiiitie ettt e e e s ne e e s ne e e s nneeesnneas 17
A, User Privilege DEPENdENCIES .........cooiviiiiiiiiiiii 17
B.  Clent USEr PrivIEgES .....c.coiiiiiiiiiiiiii ettt 18

IV. MANAGING ISSUE ITEMS...... ..ttt et et e ettt e e et e e e et e e et e e et e e e aneeeeaneeeeneeeanneeeanneas 21
Al TESEMOTE ... 22
B, SHAUS VAIUES ...t e e st r e e et e e e e 22
G MANUAI ENTIY Lot 23
[ TR 1T T =Y 0 g o] = (=S 27
T o 7= To [T g o I ETS BTSN o o PP 35
N U Lo 1 T= R v= (U PP 43
G.  ISSUE WAIENOUSE ......eiiiiiiiiiiiiiii ittt 52
TR 1 (=Y o T 0 Yo | (0 o S 58
I.  Other Options Prior to Item Presentment...... ..o 60

V. EXCEPTION IDENTIFICATION ...ttt ettt ettt ettt et et e ettt h bt ekt eb bt e e b b e et e e e nb e e ssne e e snnreennneeens 63

VI. MANAGING CHECK PRESENTMENT .........ouiiiiiiiiitiieitie ettt et e e s emb e s s e e s me e e s nr e e sneeennneeens 64
AL Transaction HiStOry ... 64
[ @ o o] o F= | o1 1 o 1S 71

RV IR 2 = 0 T 1 SRRSO 73
A, Issue Item Status RePOI ... 73

VIIl. PAYEE POSITIVE PAY TIPS & BEST PRACTICES ...ttt 77
A.  Payee Name ComparisOn: “SCOMNG” .......coouiiiiiiiiii e 77
= R [0 1= @7 =Tt o T =1 ] SR 78
C. Other Common Check FOrmatting ProbIEMS ..........u i et e nnmea 84
[ TR V1) 0 L= YN = == 0 = T | T 85

ACH MEW U\:)Zr;cue)g 5.3%70;3\64212 Page 3 of 132

an Alkami Solution Team



TABLE OF CONTENTS

PAGE 2

IX. PREFERENGES ...ttt e ettt oot e e oottt e e e e b ettt 2o e st e e e e e m bt e e e e e sne e e e e e mteeeeeamneeeeeaas 92
N e (Y (T Y o SO 92

APPENDIX A — MESSAGE ALERTS ... ..ottt e e n e e s e e e e e e nnes 94

APPENDIX B — QUICKBOOKS ISSUE FILE EXPORT ......c.uttiiiiiiiiiieiniei et n e a e 95
A. Exporting from QuiCkBOOkS ACCOUNE REGISTEN........oiiiiiieiii et 95
B. Exporting from QUICKBOOK REPOIMS......cciiiiiiiiiiiiiiiiiiii ettt 111
C. Loading the QUICKBOOKS ISSUE FilE........uuuuiuiuiiiiiiiiiiiiiiiiiiiit it 129

APPENDIX C — DOCUMENT REVISION INDEX ...ttt et e e aeee et e e e e e e et e e e e e e e e e e aneeeeeans 132

ACH MEW U\;Z;stlgg 5.3(}.370;%;12 Page 4 of 132

an Alkami Solution Team



. WELCOME TO PRO-CHEX!

PRO-CHEX is a check positive pay service designed to empower account holders (our “Clients”) with the
ability to prevent financial loss due to check fraud. This guide is intended to provide information to Clients in
choosing and using the level of protection best suited for their needs.

1. The PRO-CHEX service is highly configurable. This guide will outline all PRO-CHEX functionality, but it is
important to note that some features will only be available if the feature has been enabled by the financial
institution (FI) and/or the Client user has been granted the appropriate user privilege required to access
the feature.

2. The table below lists the PRO-CHEX positive pay types available for each account enrolled in PRO-
CHEX, a description of expected behavior and protection level ranking. PRO-CHEX relies on Clients to
make daily decisions, when required, for the check activity that occurs on their account. When accounts
are enrolled, a default setting can be established for the system to return or pay a transaction if the user
fails to do so by the established end-of-day cut-off time. The last column in the table defines the default
settings available for each type of positive pay service.

Positive Pay Protection | Default Setting
Type Service Description Level Options

This service requires the Client to provide a list of checks that have
been issued or voided on an account (Issue Items). The issue items
for each account must include, at a minimum, a check serial
Standard number, amount, and status (issued, voided, stopped). The

Positive Pay financial institution compares each check presented for payment LY P CIFRE
(Item) against the list of issue items. If an exception is identified,
designated Client users are alerted to make a pay or return
decision.
ACH MEW Version 2.0.7 rev 4
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Payee Positive
Pay

Support
Multiple Payee
Names

This is an add-on feature to Standard Positive Pay. If this feature is
utilized, Clients are required to provide the payee name for each
issue item. The financial institution will compare the name in the
issue item against the name that appears on the “Pay to the Order
of” line of the check presented for payment. A scoring method will
be used to determine the likelihood of a match, and if the score falls
below the established threshold, the item will be flagged as an
exception. It is important to note that payee name scoring is subject
to a lot of variables. Scoring can fail items that should pass if
Clients fail to perform best practices. Refer to Section VIIl. Payee
Positive Pay Tips & Best Practices for more information.

PRO-CHEX has the ability to accept multiple payee names in an
issue item file and validate multiple payee names on checks
presented for payment. Multiple payee names can be placed on a
single line or multiple lines.

High

High

Pay or Return

Pay or Return

Reverse
Positive Pay

This service does NOT require Clients to provide a list of issued
items. Clients will need to login every day to view checks presented
for payment and select the checks they want to return because the
concept of an exception does not exist since there is no list of issue
items to compare items against. However, Clients may request the
financial institution establish a maximum check amount per account
(Exception Limit). If this optional setting is enabled, an alert will be
sent to designated Client users ONLY when a check is presented
that exceeds the maximum amount established.

AR S,
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3. PRO-CHEX offers alerting (notification) to call designated Client users to action when required. PRO-
CHEX is designed to ensure notifications are relevant, but each Client can advise the financial institution
of notification levels that best suit their needs. Email alerts are standard. Clients can receive texts alerts if
the Fl has chosen to enable the text alerts feature.

4. The table below outlines a list of events that trigger an alert to a Client, a description of the triggering
event and if the alert type is Standard or Optional.

Standard or

Alert Type Description Optional
Occurs when a check is presented for payment that does not match the
Exception Alert issue information provided or if an exception limit is set on an account Standard
enrolled in Reverse Positive Pay.
Issuance File Load Occurs when an issue file is loaded. The alert contains status
information to indicate if the issue item loaded properly or if the issue Optional

Alert

item failed due to errors.

5. When an account is enrolled for PRO-CHEX, one of three levels of notification can be established for
exception alerts. The notification level options, description and a sample are provided in the table below.

Notification
Level

Description

Transaction Alerts

One alert for each exception identified.

Account Alerts

One alert per account when one or more exceptions are identified.

Service Alerts

One alert per client when one or more exceptions are identified on one or more accounts.

AR S,
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6. Sample Alerts — Account Level

Via Email:

‘*“i_,"'é"”“‘ Subject: PRO-CHEX Check(s) Received
FROM: PRO-CHEX@demobankusa.com
PRO-CHEX TO: default_naotification_contact@client.com

We have received one or more check transactions to Operating Account ending in xxxx7777.

Login to PRO-CHEX to review.

Sincerely,
Demo Bank USA

Contact Us

Please do not reply to this email. If you have questions about your account, please call Customer Service at (800) 555-1234 or email us at
support(@demobankusa.com

Demo Bank USA
1234 Any Street
Any Town, ST 12345

Via Text:

< PRO-CHEX @D

We have received one or more checks
on Operating Account ending in xxxx7777.
Login to PRO-CHEX to review.

ACH ME Version 2.0.7 rev 4
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7. Sample Alerts — Transaction Level

Via Email:

Check ALERT

d € Reply & Reply All —» Forward
delaerebt@achalert.info 2 TRy i
To Liz Delaere 2/21/2020

We have received a check with serial #8508 to FFFriends ending in xoom1111 for $6,130.00.
Login to PRO-CHEX to review.

Sincerely,
Delaere B&T

Contact Us
Please do not reply to this email. If you have questions about your account. please call Customer Service at (800) 555-1234 or email us at delaere/@achalert com

B i
Delaere B&T
1 Main St
Ooltewah, TN 37363

Via Text:

< PRO-CHEX D

We have received a check with serial
#148487 on Operating Account ending

in xxxx7777 for $100.75. Login to PRO-CHEX
to review.
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8. Sample Alerts — Service

Via Email:

Check ALERT

o ok £ Reply &5 Reply All “F d
Fl@achalert.info DY R cray
To Vivian Kortran Tue 3/17/2020 1:51 PM

Transactions for PRO-CHEX are available to decision.

Smcerely,
FI State Bank

Contact Us
Please do not reply to this email If you have questions about your account, please call Customer Service at (300) 555-1234 or email us at vkortman@achalert com

FI State Bank
1 Safety Way
Kennesaw, GA 30144

Via Text:

0 Transactions for
PRO-CHEX are available
to decision.

an Alkami Solution Team
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Il. PRO-CHEX DASHBOARD BOX

A. Using the Dashboard

1. The Dashboard is the default landing page within the Client portal. If PRO-CHEX is enabled, a PRO-
CHEX box will be displayed. Summary information on current check transactions and status will be
displayed for accounts the user has been granted access. Active links are embedded within the PRO-
CHEX box to permit users to navigate from the dashboard landing page into the PRO-CHEX service
module or directly to transactions in the status selected. Dashboard totals are updated in real time as
transaction status values are changed by a user.

The content displayed in the PRO-CHEX summary box includes the following:

PRO-CHEX

End of Day Cut-Off Time: Wednesday 3:00 PM EST

Exceptions $11,746.20 [ 17
Set to Pay $11,681.20 (16 ] Set to Return $65.00 (1]
Service Name In the example provided, clickihg PRO-CHEX on the left in the title bar will direct the user

to the main menu.

End of Day Cut-Off Time Displayed in the second bar, the time of day indicates when transactions that require
decisions will no longer be eligible for user decisions.

Exceptions Clicking on the dollar amount hyperlink on the Exceptions line will direct the user to a

filtered view of Transaction History that will display only exceptions that require a
decision.

ACH ME U\;z;stizg (2)333?0;3\:);12 Page 11 of 132
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Setto Pay
System
User

FI

PRO-CHEX

Exceptions $11,746.20

@
$11,681.20 (16 ] Setto Return $65.00 (1]
$11,681.20 (16 ] System $0.00 (0]
$0.00 (0] User $65.00 (1]
$0.00 (0] FI $0.00 (0]

End of Day Cut-Off Time: Wednesday 3:00 PM EST

Set to Pay / Set to Return

Clicking on the dollar amount hyperlinks on the Set to Pay or Set to Return lines will
expand the view to display a breakdown of the total for each category. System Pay or
Return indicate transactions that will pay or return if no action is taken due to the default
status. User pay or return indicate a Client user decision has occurred. Fl pay or return
indicate an FI decision has occurred on behalf of the FI.

Y Filters

Transaction ID

» 49129

> 49128

¥ 49127

» 49126

¥ 49125

Transaction History

>
181 debit transactions totaling $261,203.62
Rows 1-25 of 181.
* 4 - 2 3 4 i 3
4
Account Number Serial Number Credit Debit Current Status Dateli Change Status Exception
001111 12274 $127.00 Pay-System 08-31-2021 [:]
0001111 12274 $27.00  Pay-System 08-31-2021 0
o] 111 12273 $35.10  Pay-System 08-31-2021 [:]
300001111 12272 $20.00 Pay-System 08-31-2021 0
oox1111 12271 $200.00  Pay-System 08-31-2021 ]

Date Range
EAugust 1, 2021 - August 31, 2021~

Transaction History

ACH ALE
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The user can click on the dollar amount link for any category to be directed to a filtered
view of the Transaction History. In the above example, the user has clicked on the dollar
value of Exceptions on the Dashboard and is directed to a view of exception transactions
that require decision.

Please refer to Section VI, Subsection A, Transaction History, for more information
on this function.
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2. From the Client Dashboard, a user can navigate to the PRO-CHEX Module by clicking Change Module >
PRO-CHEX.

Dashboard 2 Manage Users Wi Reports - = Transaction View Change Module ~ 2 Prg

=P [ PRO-CHEX ]

PRO-CHEX

End of Day Cut-Off Time: Wednesday 6:00 PM EST

Exceptions $18,377.83 [ 14 ]

Setto Pay $17.713.28 (12 Set to Return $664.55 (2]

B. Creating Client Users

NOTE:

» The Admin user privilege must be enabled.

> This feature is only available if 1) the Fl is allowing Clients to manage their own
users, and 2) it will only display for Client users who have been designated with
Client Admin status.

A Client User with Admin user privilege can add additional Client users who will then be authorized to use
PRO-CHEX.

1. From Client Dashboard > Click Manage Users.

ransaction View Change Module -

Dashboard i | \-1Enagi Users i Reports ~ =

ACH ME U\::jrastigc? (2)33;0;3\:);12 Page 13 of 132
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2. The Client Users page appears

. Click the “Create New User” button.

Create New User R ey

Select User

S€ea

2 Doe, jane

2 marks, David

User Type

Normal

Please select an existing user or create a naw one.

3. The New User page appears. Fill out all fields available, the click “Create User” button.

Cuthbert Allgood

First Name

Cuthbert

Email Address

cuthberta@finefeathers.com

Last Name

Allgood

Contact Phone Number Cell Phone Number

(555) 555-5555 | (555) 555-5555

4.

If the user is configured for standard security login, the New User interface will display these fields.

Cuthbert Allgood

B Active

Username
95teaXplg

First Name

Cuthbert

Email Address

cuthberta@finefeathers.com

Last Name

Allgood

Contact Phone Number Cell Phone Number

(555) 555-5555 (555) 555-5555

Version 2.0.7 rev 4
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5. If the user is configured for single sign-on, the New User interface will display these fields. Please note
that the SSO ID field can have different labels and formats based on the online banking provider being
used. It is important to note that the maximum number of allowable characters in the SSO ID field is

limited to 50.
Judy Dench
Active Admin (Manage other non-admin users)
S50 1ID
|Dench
First Name Last Name
Judy Dench
Email Address Contact Phone Number Cell Phone Number
jdench@testbank.com (595) 855-4858 (787) 254-1258

6. The User profile page appears. Scroll down to the “System Roles” section of the page to select what roles
should be enabled for the user. For more information on managing user entitlements, please refer to the
Fraud Prevention HQ Client User Guide, Sections Il and ll.

System Roles

[all | none]

4 Audit Report Notification Delivery Consolidated
Report Transaction History View

7. Within the PRO-CHEX settings box, the alert method can be chosen. Use the drop-down to select the
alert method desired.

PRO-CHEX Alert Method:
. Email

Available Accounts Selected Accounts Email, SMS/Text

| | |‘ SMS/Text
Email Client User will receive PRO-CHEX Alerts via Email only
Email, SMS/Text Client User will receive PRO-CHEX Alerts via Email and SMS/Text
SMS/Text Client User will receive PRO-CHEX Alerts via SMS/Text only

ACH ME Version 2.0.7 rev 4
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8. Choose from the list of available accounts enrolled in PRO-CHEX the user is entitled to work with and
move them to the Selected Accounts box.

> and < move individual accounts between Available and Selected Accounts.
>> and << move all accounts between Available and Selected Accounts.

Available Accounts Selected Accounts
FFF Escrow poooid444) FFFriends (xoom1111)
=
FFF Expense (x00(3333)
==
FFF Payroll (oox2222) s
<=

9. For more information regarding Client User Privileges, please refer to Section lll. User Accounts and
Privileges.

Version 2.0.7 rev 4
Updated 03/30/2022 Page 16 of 132
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lll. USER ACCOUNTS AND PRIVILEGES

Additional information about creating and editing Client users can be found in the
Fraud Prevention HQ User Guide, Sections Il and Ill.

Defined in this Section are Client user privileges and alerting methods supported for the PRO-CHEX

module.

E

A. User Privilege Dependencies

Some user privileges are standard, and some are dependent upon features that are enabled by your financial
institution. If you see a privilege below and it does not appear in the Client user interface, the feature has not

been enabled.

Privilege User Feature Dependencies
Issue Item Status Report Client Fl Enabled
Issue Templates Client Fl Enabled
Issue Warehouse Client Standard
Transaction History Client Standard
Load Issue File Client Standard
Item Lookup Client Standard
Change Transaction Status Client Standard
View Issue File Status Client Standard
Issue Load Alerts Client Fl Enabled
Manual Issue Entry Client Standard

ACH A g
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Page 17 of 132



B. Client User Privileges

NOTE:

» The Admin user privilege must be enabled.

1. On the Client User page, scroll to PRO-CHEX service station.

2. Choose from the list of available accounts enrolled in PRO-CHEX the user is entitled to work with and
move them to the Selected Accounts box.

> and < move individual accounts between Available and Selected Accounts.
>> and << move all accounts between Available and Selected Accounts.

Available Accounts Selected Accounts
FFF Escrow (oooid444) FFFriends (oox1111)
=
FFF Expense (xXxxx3333)
==
FFF Payroll (oox2222) ”
=

Version 2.0.7 rev 4
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3. Selecting PRO-CHEX Client User Privileges
a. Selecting all | none

i. By selecting all, the user will be assigned all user privileges.

User Privileges

[2ll | none]
Item Lookup & 1ssue Item Status Report Transaction History
Change Transaction Status View Issue File Status Issue Templates
Issue Load Alerts Issue Warehouse Load Issue File

Manual Issue Entry

ii. By selecting none, previously assigned user privileges will be removed.

User Privileges

[all | none]
Ll ltem Lookup [ Issue Item Status Report [ Transaction History
0 Change Transaction Status [ View Issue File Status [ Issue Templates
[ Issue Load Alerts [ Issue Warehouse [ Load Issue File

[J Manual Issue Entry

iii.  Clicking in the box beside each user privilege will add or remove the checkmark from the box.
Adding a checkmark will give the user that privilege, removing the checkmark will remove the
privilege from the user.

Item Lookup Ability to look up all recorded data on individual
issued items.
Item Lookup Change Transaction Requires Transaction History user privilege. Allows
Status a user to change the status of a transaction from

Change Transaction 5tatus return to pay or pay to return.

Sl Loag Merts Issue Load Alerts Will receive success or failure alerts when Clients

Manual Issue Entry load issue files.

| NOTE: Issue Load Alerts must be enabled.

Manual Issue Entry Allows the user to manually create an issue item.

| NOTE: Issue Load Alerts must be enabled.

ACH MEV Version 2.0.7 rev 4
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Issue Item Status Report
View Issue File Status

Issue Warehouse

Issue Item Status Report

View Issue File Status

Issue Warehouse

Allows the user to view issued items by status for a
specific date or date range.

NOTE: Issue Item Status Report must be enabled.

Allows the user to view the status of issue files
loaded into the system.

Allows the user to view issue items and history

Transaction History
Issue Templates

Load Issue File

Transaction History

Issue Templates

Load Issue File

Allows the user to view checks transactions that
have been presented for payment. If this privilege is
enabled, the user will also have access to an item
lookup sub-menu option.

Allows a user to create a template that defines the
format of the issue file they will load and the format
and location for the data elements that will be
provided in the file. If this privilege is enabled for a
user, the user will also be able to manage additional
issue fields.

NOTE: Issue File Mapping must be enabled.

Allows the user to load issue files via the Client
Portal.

4, Select Save User.

a. Success message appears.

User Saved

an Alkami Solution Team
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IV. MANAGING ISSUE ITEMS

Certain types of positive pay services require Clients to maintain a list of issued items for the financial
institution to compare presented items against so exceptions can be identified.

While issue items can be added after a check has been presented for payment, it is highly recommended
that Clients enter or load issue items prior to disbursing paper checks to payees, as failure to do so could
result in denial of payment if the check is presented at the teller line for deposit or to be cashed.

If issue items are entered or loaded on accounts configured for positive pay types that do not require a list,
PRO-CHEX will ignore them.

When an issued item is entered or loaded into PRO-CHEX, the status and disposition of the issued item is
tracked. The table below describes the status and disposition labels associated with issue item

management.
Labels Description
Issued A status defined by the Client that indicates a check was issued.
Voided A status defined by a Client that a check was issued but later voided and not distributed.

A status assigned by the PRO-CHEX system when an issue item is entered or loaded by a

Available for Matching Client

A status assigned by the PRO-CHEX system when a check is presented for payment with a

Used in Matching serial number that matches a serial number for an issued item.

A status displayed in the issue warehouse that indicates a check has not yet been presented

Outstanding for the issued item and it is still available for matching.

A status displayed in the issue warehouse that indicates a check has been presented against

Paid an issue item and it was paid by the system, Client user or FI.

A status displayed in the issue warehouse that indicates a check has been presented against

Returned an issue item and it was returned by the system, Client user or FI.

A status assigned by the PRO-CHEX system when an issue item that has not been used in
Purged Matching (outstanding) has been removed from the system. The purge period is defined by
the financial institution.

If an issue item is updated after it was loaded, history will be available in the issue item

Updated warehouse when the drop-down for an issue item is expanded.

an Alkami Solution Team
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Clients can request the Fl enroll accounts with an inactive status and grant users’ access to the system to
test issue file load. Issue items loaded while in test mode are marked as test issue items and will not be
displayed in the issue warehouse or used for matching against presented checks. Clients must notify the FI
when testing has been completed and they wish the account to be active.

Issued items can have a status of Issued or Voided.

1. Issued: The check has been issued and distributed for payment.

2. Voided: The check has been voided by the maker. A check is usually voided prior to disbursement. A
voided check cannot be used to make a payment or withdraw money from the account.

3. Disable Stop Payments: By default, all Finastra FI's will have Disable Stop Payments in their
configuration settings. The FI may choose to do this because they prefer to update those items in their
core banking system.

If stop payments are disabled, the client cannot:

» Load issue files with stopped status items
» Overwrite via Manual Issue Entry to change an item from Stopped to Issued or Voided
> Change a previously Stopped item to Issued or Voided via Issue Warehouse.

Page 22 of 132
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NOTE:

» The Manual Issue File user privilege must be enabled.

» PRO-CHEX will not accept issued items with a date more than two years in the past.

If the Fl enables this feature, Clients can manually enter a list of checks that have been issued. To manually
enter an issue item, the user must be granted the manual issue entry user privilege.

The table below describes a list of fields that may be displayed in the manual entry screen, the criteria for the
field to display and how the information entered will be used to identify exceptions when matching issue items
to checks presented for payment.

Field Criteria Use
To identify if the check was
Serial # The check number/serial # is always required. issued o:ypresented more than
once.
Amount | A dollar value is always required. Used to identify if the amount of a
check has been altered.
The person(s) or entities to whom the check was intended to pay. The
Pavee field will suppqrt 'entrg/ of n’f’ultiple payee names (maximum of 4' Used to identify if the name in the
Najr/n : allowed) by clicking “Enter” to input another name on the next line. “Pay to the order of” line has been
altered.
This feature is optional, and the field will only appear for accounts
configured for payee positive pay.
Each check should be accounted for, even checks that have been Used to determine if a check .
. . . . should be analyzed for matching
Status voided. The status value advises the FI if a check has been issued and (issued) or if a check was
distributed, issued, later voided and not distributed or issued. The resented for pavment that was
issued and void status values will always be available for selection. pres pay
previously voided.
Issuance | A date the check was issued and valid for payment is always required. ~ Used to determine if a check is
Date The issuance date will always default to the current date, but the user presented earlier than intended or

ACH ALE
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1. From the PRO-CHEX module, click Perform > Manual Issue Entry.

1]
T
q

PRO-CHEX £ Manage - # Perform - i Reports ~ Change Module -

Issue File Load

[ manual Issue Entry |

2. The Manual Issue File Entry screen appears.

Manual Issue Entry

Account? Auto populate next check number:
- not selected - ¥
Row Serial Number Amount Payee Name’ Status Issuance Date
/| (20,
ISSUED - 03/03/2021

© Click any row to select that row for editing

Save

Account Select appropriate Account Number from the drop-down menu.

Auto populate next  When checked, the next check number will auto-populate in the following row. This feature is
check number designed to eliminate serial number entry when checks are issued in sequential order.

When unchecked, the next check number will remain blank until it is filled in by the user.

Row Each issue item will be numbered in the order they are entered. Once the cursor is placed in the
current row, an additional row will appear for the next entry.

Serial Number Type the item serial number for this manual issuance file in the Serial Number field.

Amount Type the dollar amount for this manual issuance file in the Amount field. Or use the up and
down arrows in the Amount field to select a dollar amount.

Payee Name Type the payee name for this manual issuance file in the Payee Name field. The Payee Name
field supports the entry of a single payee, or multiple payees.

Please see Step #3 below for in-depth information about the Payee Name field and

Multiple Payee Names.
Status Issued The check has been issued.
Voided The check has been voided by the maker.

It is important to note that if the Fl has disabled stop payments, the Stopped status
option will not appear in the drop-down menu.

Issuance Date Click on the Issuance Date field and select a date from the calendar that this item was issued.

an Alkami Solution Team
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3. Payee Names: The Payee Name field supports up to four Payees.

a. Click within the Payee name field to enter Payee Name(s).

Row Serial Number Amount Payee Name’ Status Issuance Date

10100 300.00 ISSUED v = 03/03/2021

b. The view size on the Payee Name field can be enlarged by dragging bottom right corner of field box.

The feature may not be available based upon the browser used.

Row Serial Number Amount Payee Name’ Status

L 10100 300.00 ISSUED . =]

PR

Issuance Date

03/03/2021

c. Input the Payee Name in the field. If there are multiple payees, an Enter (carriage return) must be
used to input a second, third or fourth payee on separate lines in the field for it to be distinguished as

different payees.

Row Serial Number Amount Payee Name’ Status Issuance Date
: 10100 300.00 Helen jones ISSUED v = 03/03/2021
Lisa Miller y
If multiple payees are listed on a single line of the check, putting them on separate lines is not
applicable.
Row Serial Number Amount Payee Name-’ Status Issuance Date

10100 300.00 Helen Jones & Lisa Miller]

ISSUED v =

03/03/2021

d. The Payee Name field currently supports 500 characters in total. This count will include the carriage
returns separating multiple payees. The 500-character limit is for the entire field, and not per payee.

It is important to note that although 500 characters are allowed in this field, names might be
truncated if using a fixed width template and the number of characters allowed in that column

are less than 500.

4. To edit any row, click in the fields to be edited and make changes.

Version 2.0.7 rev 4
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5. When all manual issuance files have been entered, click Save button.

6. The Manual Issuance File Status detail page appears.

< Back to Status

File Status

Queued Processed

File processing is complete. View list below to see items.

@® View items: 2 Items totaling $80,001.00

MANUAL_1617197309551

Approved Completed Deleted

Load Date: 03/31/2021 09:28:29 EDT

Rows 1-2of 2.

Account Number Serial Number Amount Payee Name Status Issuance Date

wox1 111 40000 $40.000.00 Farmula 1 AVAILABLE_FOR_MATCHING 03/31/2021

001111 40001 $40,001.00 Lewis Hamilton AVAILABLE_FOR_MATCHING 03/31/2021

Delete

Load Date Date and time the file was loaded.
Account Number The account number on each issue item.
Serial Number The serial number of the issue item.
Amount The amount of the issue item.
Payee Name Name of the payee(s) from the issue item.
Status Available_For_Matching The issued item is available for exception matching against an

Duplicate Issuance

Used in Matching

incoming check.

This issued item is a duplicate and has already been issued.

This issued item has been used in the exception matching
against an incoming check.

Issuance Date Date the item was issued.

7. Click the Back to Status button to view the Issuance File Status page. For more information, please
refer to Subsection F, Issue File Status.
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D. Issue Templates

The purpose of issue templates is to make it easy to load issue items into PRO-CHEX using files that can be
generated out of most accounting systems. PRO-CHEX provides organizations a variety of flexible options for
providing a list of checks that have been issued or voided.

Issue templates allow users to select from a list of file formats supported and identify where the required data
elements are located within the file.

Once a template has been set up, the template can be selected when loading a file to tell PRO-CHEX how to
utilize the data contained in the file.

Multiple file templates can be set up, displayed and used. FI's can create templates for Clients to use or the
FI may choose to allow Clients to create their own templates.

NOTE:

» The Issue Template user privilege must be enabled.

1. From within the PRO-CHEX module, click Manage > Issue Templates.

PRO-CHEX ¥ Manage ~ # Perform ~ i Reports ~

[ Issue Templates j—

1]
m
q

Change Module -
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A screen will appear that lists any existing templates that are available for view or edit, and a button to
Create New Template. NOTE: Templates created by the Fl cannot be modified by a Client. Templates
created by the Client can be modified by the Client and the FI. Templates created by the Fl can be
viewed by clicking the eye icon in the Edit/View column.

Template File Type
Delete | Filter by File Type Edit/View
2105 Template 1 Excel Workbook S
2110 FI Level Template Comma Separated (]
HW Test Fixed Width @
MUTUAL LONG TERM CARE Fixed Width (]
] 2105 Template B Excel Workbook ’
O AP Template Comma Separated y
O New Template 1 Comma Separated ’
O Test Comma Separated P
| Test CPP-1423 Comma Separated ’
Delete Selected

2. To view or edit an existing template, click the pencil icon for the appropriate template.

3. To delete an existing template, click the checkbox next to the Templates to be deleted and click Delete
Selected. Templates that have the Delete option were built by the Client and can be deleted/edited by
the Client user. Templates without the Delete option were built by the FI and cannot be deleted/edited by
the Client user.

4. To create a new template, click the Create New Template button.

Create New Template

Template Name File Type’ Template Status
- select file type v Active v

Number of Header Rows’ Number of Footer rows’ Template Level’
9 0 Client v

Multi-Line Payee Name Separator: ?

Do not use a character as a separator if

The upper portion of the template screen will not change, regardless of the file type selected. The template
name, file type and template status values are required. The header and footer fields are optional.
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Many accounting systems can export excel or fixed width files. Sometimes those files have header
(beginning) rows or footer (ending) rows that contain data that is not required by PRO-CHEX.

When setting up a template, the Client can define the number of rows PRO-CHEX should ignore at the
beginning and end of the file. It is important to note that if the values are entered incorrectly, an issue file
may load with errors or no items.

About Multi-Line Payee Name Separator:

The Multi-Line Payee Name Separator field is optional. This feature allows the Fl to enter a
character that can be used to separate Multiple Payee Names that are on separate lines of an
issued check.

Currently, the system restricts the allowed characters to the following: ; | 5= | . The user
must be aware that using a separator character that appears elsewhere in the payee name or might
conflict with the file itself can cause issues. Examples of scenarios where problems might arise are
listed below.

Within a Comma Separated file (.csv), different data fields are separated by a comma. Therefore, a
comma cannot be used in the data field itself, or the .csv will read the comma as a separator before
the next field. Therefore, listing two payees for an item in this way: “Elain Archeron,Nesta Archeron”
will cause issues reading the .csv file. In this scenario, the user should select a multi-line payee name
separator character that will not cause an issue, such as a semicolon. “Elain Archeron;Nesta
Archeron” in the Payee Name field of the .csv file will process correctly.

If the user selects a separator character that would ever appear in a payee name field, such as a dash
(-), the system would then separate the data before and after the character as separate payees. For
instance, if the user has selected a dash (-) as the Multi-Line Payee Name Separator, and a common
payee used is “In-and-Out Burger”, the system will flag this as having multiple payees. In this case, the
user should select a multi-line payee name separator that will not cause such issues, such as a pipe
() or a semicolon for cases of multiple payee names.

Please refer to Section VIl Payee Positive Pay Tips & Best Practices for more information
about multiple payee name handling.

ACHALE Jesion 207 1.
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The mapping section below will display based on the file type selected. It is important to note that not all
fields/options seen in these graphics may be available for your organization based on settings
configured by your financial institution.

Excel and separated files will require Clients to define the column data elements that will be found.

Create New Template

Template Name File Type’ Template Status
- select file type w Active w

Number of Header Rows’ Number of Footer rows’ Template Level®
L} o Client W

Multi-Line Payee Name Separator:

Do not use a character as a separator if
that character will ever be presentin a
Payee Mame. Allowed characters in
brackets[; |, -_/]

his Client has not been setup for client additional issue fields in templates,
Configure in Client level settings and setup dient additional issue fields for the Client and try again.
File Mapping
Add  Input Field’ File Column® Field Format
Serial Number
Amount’ @ Fractional Dollars (12.34)
O Whole numbers of cents (1234)
Crars’ —for ISSLIED
Status I5SUED for ISSUED

VOIDED - for VOIDED

Account Number’
Issuance Date’
O Payes Mame’

0 Routing Number’

- Place the cursor over this label for more information

LA
o
=
i
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Fixed Width files will require the Client to define the start and end position in which the data element
is located.

Create New Template

Template Mame File Type Template Status
Fixed Width b Active b4

Number of Header Rows’ Number of Footer rows’ Template Level
0 th] Client '

Multi-Line Payee Name Separator: *

Do not use a character as a separator if
that character will ever be present in a
Payee Mame. Allowed characters in
brackets[; | .-_/]

This Client has not been setup for client additional issue fields in templates.
Configure in Client fevel settings and setup dlient additional issue fields for the Client and try again.
File Mapping
Add  Input Field’ Start Position’ End Position’ Field Format
Serial Numiber
Amount’ @ Fractional Dollars {12.34)
21 Whole numbers of cents (1234)
Status’ ISSUED - for ISSUED

VOIDED - for VOIDED
O Agcount Number®
O Issusnce Date’

O Payes Name’

O Routing Number’

i *- Place the cursor over this label for more information
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The mapping section on the lower part of the screen displays the required fields. The Check Serial
# and Amount fields are always required. The Client must specify if the amount data in the file to be
imported will or will not contain decimal points. For example, if the Amount value is set to Fractional
Dollars, then 100, 100.0 and 100.00 are all processed the same. If the Amount value is set to
Whole numbers of cents, the system will divide by 100 and save it as a dollar value. For example, a
value of 100 would be saved as $1.00 in the system.

The Client may choose to import additional data by checking the Add box next to the desired data element.

If the Status box is not checked (as shown below), PRO-CHEX will load all issue items with a status of
Issued. If the Client file represents Voided items as a negative number, the Client can check the box Treat
Negative Amount as Void and PRO-CHEX will status any item in the file with a negative value as Voided.
Issuance with a $0 amount will also be treated as void.

Create New Template

Template Name File Type’ Template Status
- select file type b Active »

Number of Header Rows’ Number of Footer rows’ Template Level’
0 0 Client bt

Multi-Line Payee Name Separator: ’

Do not use a character as a separator if

that character will ever be presentin a
Payee Name, Allowed characters in
brackets[; i)
File Mapping
Add  Input Field’ File Column’ Field Format

Serial Mumber

Amount? @® Fractional Dollars (12.34)
7 Whole numbers of cents (1234)
O Status’ Treat Negative Amount As Void’
Issuance with $0 amount will be treated as Void
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Create New Template

Template Name File Type’ Template Status
Fixed Width » Active v

Number of Header Rows’ Number of Footer rows’ Template Level’
0 ] Client b

Multi-Line Payee Name Separator: ’

Do not use a character as a separator if

that character will ever be presentin a
Payee Mame. Allowed characters in
brackets[; ]
File Mapping
Add  Input Field’ Start Position’ End Paosition” Field Format

Serial Mumber

Amount’ ® Fractional Dollars (12.34)
O Whaole numbers of cents (1234)
El Status’ Treat Negative Amaount As Void’

Issuance with $0 amount will be treated as Void

If the Client checks the Status box additional fields will display as shown below. If the Client’s accounting
system exports issue items with an Issued and Voided status, no additional action is required.

Status’ [SSUED - for ISSUED

LR - for VOIDED

It is important to note that if the Status box is checked for a template, and this information is not provided in
the issue file loaded, the system will give each record an ISSUED status.

If the accounting system used exports issued items with a value of X and voided items with a value of Y,
the user can identify the values as shown below so PRO-CHEX can translate the data appropriately when
importing the data.

Ctatus’ , - for ISSUED

- fior VOIDED

A description has been provided below to define system behavior if additional data elements are included.
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Account #

Issuance Date

If the account box is selected, the user can import one file that contains issue items for
multiple accounts. If the account box is NOT selected, when a Client user loads a file through
the Client portal, PRO-CHEX will require the user to select the account the checks were issued
on.

If the issuance date box is NOT checked, PRO-CHEX will default the issue date to date the file
was loaded. If the issuance date box is checked, the file must contain an issuance date for each
item. For Excel files, PRO-CHEX will translate the data format used in the file. For separated and
fixed width files, the Client must define the date format being used as shown in the screenshot
below. It is important to note that the formats displayed are examples only, a complete list of date
formats can be found at:

https://docs.oracle.com/javase/8/docs/api/javal/time/format/Date TimeFormatter.html#patterns

Issuance Date’

M for month, d for day of month, y for year
Examples:

wyyy-MM-dd for 2019-12-25

MM/ddyy for 12/25/19

MMM dd, wyyy for Dec 25, 2019

Payee Name

ACH ALE
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The Payee Name box will only appear if one or more accounts are configured for payee positive
pay. If the payee name box is checked, PRO-CHEX will require the payee name for accounts
configured for payee positive pay. If payee name is provided for accounts not enrolled in payee
positive pay, the payee name data will be ignored when the file is loaded. For Excel or delimited
files, the complete and single payee name is expected in a single column. For fixed width files,
the complete and single payee name must be contained in the file between the starting and
ending position.

If Multiple Payee Names feature is enabled, the Issuance Payee name may display more
than one payee.



NOTE:

> The Load Issuance File user privilege must be enabled.

> PRO-CHEX will not accept issued items with a date more than two years in the
past.

> If Multiple Payee Names feature is enabled, PRO-CHEX will support more than one
payee name in the Payee Name field of issuance files. Please see Step #2 below for
more information.

> lIssue file loading will strip and ignore dollar signs on dollar amounts, and double
and single quotations around data fields.

> For best results, users should not load issue files with mixed account numbers
unless they have access to all the listed accounts. Loading issue files with account
numbers for which the user has no access will cause errors.

> There is a 100-character limit on issuance file names.

PRO-CHEX allows Client users to load issue files into the system for use in matching. PRO-CHEX accepts
these files in a variety of formats, used in conjunction with file templates (covered in the previous subsection).

1. From the Client Portal:

a. PRO-CHEX module, click Perform > Issue File Load.

PRO-CHEX £ Manage ~ | # Perform - ot Reports -

[ Issue File Load ]4—

Manual Issue Entry

b. The Load Check Issuance File page appears.

Issue File Load

Template to Use With Issue File

- salect template - w Create New Template

Select template that matches issue file format

- - Updated 03/30/2022 Page 35 of 132
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c. Select the Template drop-down box to select from a list of existing templates. Select one of the
available templates listed. If only one template is available for a client, the drop-down box will select
that template by default.

Issue File Load

Template to Use With Issue File

- select template - v | Create New Template

- select template -

DBFI Fixed Width

Excel 97-2003 Workbook
Excel Workbook 2
TestTemplated
tester

d. If the template selected was created without the Account field enabled, then a drop-down box will
display so that an Account can be selected. Select from the list of accounts. If only one account is
available for a client, the drop-down box will select that account by default.

Issue File Load

Template to Use With Issue File Account?

Excel Workbook 2 v - not selected - v | Create Mew Template

- not selected -

FFF Escrow - xoomxd444
FFF Expense - xxxx3333
FFF Payroll - xxxx2222
Select account and template that matches issue file format| FFFriends - oot 111

View Selected Template
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e. The file upload interface will appear. Click the Browse button to select the appropriate file.

Issue File Load

Template to Use With Issue File Account?

Excel Workbook 2 w | FFFriends - 0001111 v Create Mew Template

View Selected Template

Select one issue file that is in the format of the selected template

1
i
1]
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o
v
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f.  Once the file is selected, it will be displayed in the upload interface.

Issue File Load

Template to Use With Issue File

Excel Workbook 2 A

View Selected Template

[N

B Issue 0529-001 xlsx

Select one issue file that is in the format of the selected template

FFFriends - wom1111 w Create New Template

M Remove = @ Upload

Remove The file will be removed from the page.
Browse Use Browse to locate the file you want to load.
Upload The file will be uploaded.

g. The Status Bar will display the current status of the file.

= Back to Status

WKP1 Issue 1028-001.xlsx

File Status
Queued Processed Approved / Rejected Completed Deleted
File is processing ..
ACH ME Version 2.0.7 rev 4
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h. If errors were encountered during the initial processing of the issuance file, the Parse Errors display

will appear, allowing the user to view the error detail within the file. The most common reason this
error would appear is because the file contains improper formatting. At this point, the user will have
the option to:

>

Correct those errors.

Delete individual errors. This feature only displays if there are errors in the file and is only

available until errors have been corrected and the file is saved.

Delete all errors. This feature only displays if there are errors in the file and is only available until

errors have been corrected and the file is saved.

o This will retain the totals and counts for audit history.

Discard the file. This feature shows up when there is an error in the file. This option is not
available after corrections have been made and saved.

This will remove the file and its contents from the system.

< Back to Status ASBC1 Issue 0415-004.xIsx
File Status
Queued Processed Approved / Rejected Completed Deleted
Errors occurred during loading. View list below to edit errors. If errors remain after 04/21/21, the issuance file will be automatically discarded.
@® Edit 4 Errors
Rows 1-4 of 4,
Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date
7 21111 11568 $30.00 Richard Canova ISSUED 04/15/2021
[ 21111 11567 $260.00 Office Pride ISSUED 04/15/2021
5 FAREE] 11566 $600.00 Jonathan Copeland ISSUED 04415/2021
Michael Copeland
4 z1111 11565 $65.55 Cisco Webex, LLC ISSUED 04/15/2021
O Click any row to select that row for editing
Discard File

Delete

@

i

i)

In this case, the account numbers in the issuance file were entered incorrectly and they need to be
corrected before the file can be fully processed and loaded.
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i. Click on any of the fields highlighted in red to make updates or changes.

@ Edit 4 Errors
Rows 1-4of4.
Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date Delete
zi11n 11568 30 Richard Canova ISSUED 2021-04-15
- select accounr W 11568 $ 30 3 ISSUED w = 04/15/2021 =
7 | Richard Canova m

- select account -

OctaTest - 008888

The One and Only - ot 111
PC Test - oo 1369

Gilbert's Grapes - xxxx6732

=]

11567 $260.00 Office Pride ISSUED 04/15/2021

(a1

In this example, the user is presented with an account number drop-down so they can choose the
correct account number for the issuance item.

j- Once all errors have been corrected, the red highlights are no longer visible, and the file can be
reprocessed by clicking the Save and Submit button. This feature is only available until all errors are
corrected, deleted, or discarded.

® Edit 4 Errors
Rows 1-4 of 4,
Line
Number Account Serial Number Amount Payee Name’ Status Issuance Date Delete
7 The One and Only 11568 £30.00 Richard Canova ISSUED 04/15/2021 i
- %o
4] 2+HHH HEEF 26660 SifieaPride I55UED S22 Y
5 The One and Only 11566 $600.00 Jonathan Copeland ISSUED 04/15/2021 (]
- o111 Michael Copeland
4 The One and Only 11565 $65.55 Cisco Webex, LLC ISSUED 04/15/2021 [
- %011
@ Click any row to select that row for editing 1
Discard File Save and Submit
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k. The file will be returned to processing.

SBaktostas PGO1 Issue 0303-002.xlsx

File Status

Queued Processed Completed Deleted

File is processing . ..

I. If the file processes successfully, the user will be able to view the details on all the items in the file.

+ Back to Status PGO1 Issue 0303-002.xlsx

File Status

Queusd Processed Approved Completsd Delzrzd

@ View items: 15 Items totaling $12,245.81 Load Date; 03/03/2021 15:07:38 EST

Account Number Serial Number Amount Payes Name Status Issuance Date
aoox3TE3 2665 T65.55 Cisco Webex, LLC NEW_ISSUANCE_ITEM 037032021
ox3TE3 2668 $600.00 Jonathan Copeland NEW_ISSUANCE_ITER 03/03/2021

M Copeland

woox37E3 2667 £260.00  Office Pride NEW_ISSUANCE_ITEM 03/03/2021
w0 3TE3 26638 £75.00 Richard Canova NEW_ISSUANCE_ITEM 03/03/2021
003783 2669 ‘Wallar Lansden Dortch & Davis, LLP MNEW_ISSUANCE_ITEM 03/03/2021
A0x3TE 2670 £24.00 Advanced Medica NEW_ISSUANCE_ITEM 03702/2021

2uxx3783 2671 $6,130.00 Citizens Union Bank MEW_ISSUANCE ITEM 03/03/2021

3783 2671 $53.36 Lowey Seminars NEW_ISSUANCE_ITEM

anox3TE3 2673 19353 Cuyshoga County Clerk NEW_ISSUFANCE_ITEM

e 3TER 2674 £2,800.00 zel Farrel NEW_ISSUANCE_TTEM G3/03/2021
*xxx37E3 2675 $150.00 21 a Archeron NEW_ISSUANCE_ITEM 03/02/2021
Elain Archeran
oex3TE3 2676 £150.00 Jake Chambpers NEW_ISSUANCE_ITER 03/03/2021
axx3TEI 2677 ABC Carpentry NEW _ISSUANCE_ITEM 03/03/2021
o37E3 2678 £35.00 {Office Pride NEW_ISSUANCE_ITEM 03/03/2021
w3783 2679 FedEx NEW_ISSUANCE_ITEM G3/03/2021
Deleta

If there are no errors in the file during the initial load, then the file will automatically display as
approved and complete.
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2. Multiple Payees:

PRO-CHEX has the ability to support customers with multiple payee names on issued items. The system
can score multiple names on a check against information provided in the issuance file.

a. When the Client user loads issue files into the system, the loaded file is processed with the Issue
Template set up within PRO-CHEX. The Issue Template allows for selection of a Multi-Line Payee
Separator, a character chosen to separate the names of multiple payees in the issue file.

b. If multiple payees are listed on a single line of a check, no action needs to be taken.

c. If multiple payees are listed on two or more separate lines on a check, the multiple payee separator
character (which should match the one designated in the template), must be used between each
name. In the example below, the Multi-Line Payee Name Separator designated in the Issue Template
is a pipe (|). The issue items shown are entered with the pipe separator between each name, with no

spaces.
1 2 2 4 5 6 T 8 9| 10 (11 12 13 14 15 16 17

1 Type Num Date Name tem Account Paid Amount Original Amount

2 4

3

! | o
4 Bill Pmt -Check 9384 06/07/2020 Jonathan Copeland|Michael Copeland 1111111111 $65.55
P Nesta Archeron|Elain Archeron|Micah |
5 Bill Pmt -Check 9385 06/0712020 Archeron 1111111111 $600.00

When the issue file is loaded, the system would then separate the data before and after the character
as separate payees.

Please refer to Subsection D of this Section, Issue Templates, for more information about
Multi-Line Payee Name Separators and how best to utilize this feature.
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F. Issue File Status

The purpose of the Issue File Status feature is to provide Client users the ability to view and/or manage issue

files loaded or manually entered by the client. The disposition or status of the file is available. Authorized
client users can also manage these files as outlined in the next section.

1. View Issue File Status

NOTE:

> The View Issuance File Status user privilege must be enabled.

a. Within the PRO-CHEX module, click View > Issue File Status.

PRO-CHEX  #¥Manage~  # Perform ~

i Reports ~ EView ~ Change Module -

[ Issue File status Je—

Issue Warehouse

We | CO‘ m e Transaction History

i Item Lookup
Plaocayjes the showe s to ealarct S0 acting
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b. The Issuance Files Status page appears.

; Date Range
Issuance Files Status E
Ejuly 15, 2020 - July 21, 2020+~
Y Filters >
10 files totaling $121,719.10
Rows 1-10 of 10.

Issuance Load ID File Name Status Load Date/Timel: Transaction Count Transaction Total View/Manage
> 5873 Acme2 Issue 0721-001.xlsx SYSTEM_APPROVED 07/21/2020 08:55:38 EDT 13 $12,171.81 Manage
> 5872 Acme Issue 0721-001.xlsx SYSTEM_APPROVED 07/21/2020 08:54:57 EDT 15 $12171.81 Manage
> 5850 Acme2 Issue 0720-001.xlsx SYSTEM_APPROVED 07/20/2020 09:23:31 EDT 15 $12171.81 Manage
> 5849 Acme1 Issue 0720-001.xlsx SYSTEM_APPROVED 07/20/2020 09:23:11 EDT 15 $12,171.81 Manage
> 5833 Acme2 Issue 0717-001.xlsx SYSTEM_APPROVED 07/17/2020 09:39:38 EDT 15 $12171.81 Manage
> 5832 Acme Issue 0717-001.xlsx SYSTEM_APPROVED 07/17/2020 09:38:54 EDT 15 $12171.81 Manage

c. To filter the date range of files shown, click on the Date Range drop-down.

Date Range

Issuance Files Status o
E=july 15, 2020 - July 21, 2020~

Y Filters Tomorrow
10 files totaling $121,719.10 Today
Rows 1- 10 of 10. Yesterday
Issuance LoadID  File Name Status Load Date/Timedi Transaction Count  Transacti
» 5873 Acme2 Issue 0721-001.xlsx ~ SYSTEM_APPROVED  07/21/2020 08:55:38 EDT 15 g+  This Month
Last Month
> 5872 Acme? Issue 0721-001.xlsx SYSTEM_APPROVED 07/21/2020 08:54:57 EDT E b $1
Custom Range
> 5850 Acme2 Issue 0720-001 xlsx SYSTEM_APPROVED 07/20/2020 09:23:31 EDT 15 %7 E Cancel
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d. To narrow the search results, click Filters and a window containing additional search criteria will

appear.

: Date Range
Issuance Files Status - :
mMay 1, 2020 - May 31, 2020~
Y Filters v
Issuance Load ID Status Min Amount
- select status - w g
Max Amount
Reset

Issuance Load ID The ID number associated with the specific file.
Status Client_Approved The file was approved by the client.

Client_Discarded

Edit_Pending

Failed
Fl_Approved

Ineligible_ltems

Loading
Processing
Queued

Suspended

System_Approved

System_Discarded

ACH AI.EI‘I'
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Client discarded means a client user decided to discard the issue file
before it was fully processed into the database.

A file in this status was loaded with errors. Before the file can be
processed into the database and be displayed in the issue warehouse

or be used in matching, the errors will need to be cleaned up or
removed from the file.

The file failed to load.
The file was approved by the FI.

The file contains ineligible items, and the load did not complete
successfully. Ineligible items will need to be removed and the file
reloaded.

The file is loading.
The file is processing.
The file is in line awaiting a status change.

The file has been suspended.

The system is set to default approve the file.

Discarded files are files that a client user loaded to PRO-CHEX and
had errors that need to be cleaned up. If the errors are not cleaned up
by deadline displayed under the progress bar, which is three days, the
file will be automatically discarded by the system and no record of it will
be kept.
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Test Approved In test mode a client user is able to load issue files to make sure that
the issue template that was created and the file loaded to the system
correctly. This function informs the user if the file will process in the
regular user interface, but items are not available for matching in test

mode.
Min Amount The minimum dollar amount of the entire file.
Max Amount The maximum dollar amount of the entire file.

e. Once search criteria are selected, click Apply to narrow your search results.

f. Search results are displayed in pages of 25 items. If the search contains more than 25 issue files, the

results will be displayed on multiple pages. Use the navigation buttons at the top of the search results
to review all results.

Issuance Load
ID File Mame

Issuance Load ID The ID number assigned by PRO-CHEX when a file is loaded. Their value only
comes into play if the Fl needs to contact ACH Alert regarding an issuance file
loading problem they cannot troubleshoot themselves. These pieces of
information should be provided in any helpdesk ticket opened.

File Name The file name assigned by the Client at load time. If the transactions were
manually entered the file name will appear with a prefix of MANUAL followed by a
system generated number sequence for ease of differentiation.
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Status

Load Date/Time

Load
Status Date/Timel;

Please see #4 in this section for a list of possible Status codes.

The date and time this file was loaded.

Transaction Count

Transaction Total

View

Manage

Transaction Transaction
Count Total View/Manage

The number of transactions contained within the file.

The total dollar amount of the transaction.

Displays View button if a file has no errors or is ineligible to be edited.

Displays Manage button if the file contains errors that can be edited. See below
for more information.

2. Click the arrow (>) next to the Client Code to view more useful detail on each issuance file.

v 4832 Issue 0528-001.xlsx FAILED 05/29/2020 09:59:20 View
EDT
File Id: Status Message: Unable to parse file. Error reading record #2
W A4AB2a MANUAL_ 1590702542494 SYSTEM_APPROVED  05/28/2020 17:49:02 6 $3,099.60 Manage
EDT
File Id: 2854
File ID The ID number assigned by PRO-CHEX once an issuance file is processed and

Status Message

an Alkami Solution Team
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committed to the database. If an Issuance Load ID is present but a File ID is
not, the file was received but did not load properly or has not been processed
all the way to the database. The File ID is useful when contacting ACH Alert
Help Desk about a problem with a file.

Displays error messages, approval or rejection data, or indicates if an issue file
has been deleted.
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3. Click View button to view the individual issue files. The [File Name] page appears.

< Back to Status WKP1 Issue 0302-002.xIsx

File Status

Queusd Processed Approved Completed Deleted

matching
@® View items: 15 [tems totaling $12,246.81 Load Date: 03/02/2021 11:36:23 EST
Rows 1-150f 15,
Account Number Serial Number Amount Payee Name Status Issuance Date
w0111 13788 $65.55 Cisco Webex, LLC USED_IN_MATCHING 03/02/2021
oot 111 13789 $600.00  jonathan Copeland USED_IN_MATCHING 03/02/2021

Michael Copeland

ool 111 13730 $260.00 Office Pride USED_IN_MATCHING 03/02/2021
001111 13791 $75.00 Richard Canova USED_IN_MATCHING 03/02/2021
oo 111 13792 $933.00 Waller Lansden Dortch & Davis, LLP USED_IN_MATCHING 03/02/2021
o111 13793 £24.00 Advanced Medical USED_IN_MATCHING 03/02/2021
woecd 111 13794 $6,130.00 Citizens Union Bank USED_IN_MATCHING 03/02/2021
File Status Bar Displays progress of issue file. This feature automatically refreshes and keeps the user
informed on the status of the file as it goes from Queued to Approved or Failed.
Load Date The date and time loaded of each item within the file.
Account Number The Account Number of each item within the file.
Serial Number The serial number of each item within the file.
Amount The dollar amount of each item within the file.
Payee Name If Applicable, the name of the payee of each item within the file.
Status Available for Matching Items marked as Available for Matching are issue items that

have loaded to the system but have not been matched to a
presented item.

Used in Matching Iltems marked as Used in Matching are issue items that a
presented item has been matched to.

New Issuance Item This status will only display in a file that was not loaded to
the database for processing.

Ineligible for Modification Items ineligible for modification are items that have been
matched to presented items and are either in a current
status of paid or returned and can therefore no longer be
modified.

Duplicate Issuance Duplicate issuance items are issue items that duplicate
previously loaded issue items exacitly.

Issuance Date The date of the issued item.
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4. Manage Issue File Status

NOTE:

> The Load Issuance File user privilege must be enabled.
» The View Issuance File Status user privilege must be enabled.
» The Manual Issue Entry user privilege must be enabled.

a. Click Manage button to edit errors within an issue file. The [File Name] page appears.

i Correct ltems.

1) Fields highlighted in red have an error and are blocking the issue file from loading all the way
to the system.

2) When a highlighted field is clicked the user can either select the correct data from a dropdown
or enter it in directly in the field.

3) Once all errors have been corrected, the user can click Save and Submit at the bottom, so the
file is reprocessed.

® Edit 9 Errors
Rows 1-%0of9.
Line
Number Account Serial Number Amount Payee Name’ Issuance Date Delete
5555555555 9255 685.55 Cisco Webex, LLC 2020-05-28
-select account - b 9255 % 65.55 - : = 05/28/2020 =
4 Cisco Webex, LLC I
&
5 9256 5600.00 Jonathan Copeland 05/28/2020 [
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ii. Delete Items
1) Individual items can be deleted from the errors screen if the option is available.
2) The user would click the trashcan in the Delete column to delete any individual items.

3) Once items have been deleted, the user can click Save and Submit at the bottom, so the file
is reprocessed.

a) The user can also click Delete All Errors at the top of the delete column.

4) This will allow the rest of the file to process into the system.

= Back 1o Status Issue 0529-001 .xIsx
File Status
ueued Processin Processed Approved Complete Deleted
g p
Errors occurred during loading. View list below to edit errors. If errors remain after 06/03/20, the issuance file will be automatically discarded,

@® Edit 9 Errors

Rows 1 af 9
Line
Number Account Serial Number Amount Payee Name’ Issuance Date Delete
4 5555555555 9255 $65.55 Cisco Webex, LLC 05/28/2020 i
5 5555555555 9256 £600.00 Jonathan Copeland 05/28/2020 fi]
6 5555555555 9257 $260.00 Office Pride 05/28/2020 [i]
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iii. Discard a File
1) An entire issue file can also be discarded.
a) The user can click the discard button at the bottom of the screen.

b) Another option is to allow the system to discard the file automatically after three (3)
business days.

In both instances, the system will act as if the file never existed and any issue information
from the file will not appear in any reporting or view.

< Back to Status Issue 0529-001.xlsx

File Status

Queued Processing Processed Approved Complete Deleted

Errors occurred during loading. View list below to edit errors. If errors remain after 06/03/20, the issuance file will be automatically discarded

® Edit 0 Errors

Rows 1-90f9.

NLI.IJI-':EEF Account Serial Number Amount Payee Name’ Issuance Date Delete
4 5555555555 9255 $65.55 Cisco Webex, LLC 0572872020 fi]
5 5555555555 5256 £600.00 Jonathan Copeland 05/28/2020 i
6 5555555555 9257 5260.00 Office Pride 05/28/2020 i
7 5555555555 9258 0 Richard Canova 05/28/2020 i
8 5555555555 9259 $933.00 Waller Lansden Dortch & Davis, 05/28/2020 fi]

LLP
g 5555555555 9260 0 Richard Canova 05/28/2020 i
10 5555555555 9267 $53.36 Richard Canova 05/28/2020 i}
1 5555555555 9262 $24.00 Advanced Medical, Inc, 05/28/2020 i
12 5555355555 9263 $6,130.00 Citizens Union Bank {v) 05/28/2020 i

© Click any row to select that row for editing

Discard File Save
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G. Issue Warehouse

PRO-CHEX provides Fl and Clients with the visibility to see the status of all issued items. Authorized Client
users can modify items in the Issue Warehouse. Clients can use the Issue Warehouse to search for issued
items for a Client or specific account using one of the many filtering options available.

NOTE:

> The View Issuance Status user privilege must be enabled.

1. Within the PRO-CHEX module, click View > Issue Warehouse.

PRO-CHEX ¥ Manage « # Perform ~ 1 Reports = = View - Change Module -
= ¥ J

Issue File Status

| 1ssue warehouse | ——
We | CO m e Transaction History

Item Lookup

Ploace yjce the ohowe menn to galart a0 actioo

2. The Issue Warehouse page appears.

Date Range
Issue Warehouse o
EMarch 3, 2021 =
Y Filters >
31 transactions totaling $25,018.62
Rows 1 - 25 of 31.
Account Serial Issue Load . 3 Issuance
ItemID Number Number Payee Name Type Match Status Amount Date/Timeli Date Update

> 2386366 wom3783 100945 Moe Green ISSUED OUTSTANDING $525.00 03/03/2021 16:09:37  03/03/2021 Vs
EST i

> 2386349 003783 2679 FedEx ISSUED OUTSTANDING $26.97 03/03/2021 15:07:38  03/03/2021 ya
EST =

> 2386348 0om3783 2678 Office Pride ISSUED OUTSTANDING $35.00 03/03/2021 15:07:38 03/03/2021 F
EST

> 2386347 oom3783 2677 ABC Carpentry ISSUED OUTSTANDING $750.00 03/03/2021 15:07:38  03/03/2021 pa
EST =

¥ 2386346 oom3783 2676 Jake Chambers ISSUED OUTSTANDING %150.00 03/03/2021 15:07:38  03/03/2021 ya
EST =
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3. To filter the date range of items shown, click on the Date Range drop-down.

Date Range

Issue Warehouse =
=mMarch 3, 2021 -

Y Filters =
31 transactions totaling $25,018.62 Today
Rows 1 - 25 of 31. Yesterday
& | 2 [ | Last 7 Days
This Month
Account Serial Issue Load e
ItemID Number Number Payee Name Type MatchStatus  Amount  Date/Timeli Custom Range
? 2386366 xox3783 100945 Moe Green ISSUED OUTSTANDING $525.00 03/03/2021 16:09: Cance

EST

4. To narrow the search results, click Filters and a window containing additional search criteria will appear.

Date Range
Issue Warehouse . -
=March 3, 2021
Y Filters v
Account’ Serial Number Date Range Filter Type
-lotstleried. * O Issue Date ® Load Date
Min Amount Serial Number Range
W i amoing Min Serial Num Max Serial Num Issue Type
SE = s - select issue type - W
ol o i Match Status
- select match status type - v
Apply ' Reset
Account Type an account name or the last 4 digits of the account number.
Serial Number Type the item serial number for a specific issued item.
Date Range Issue Date: If selected, issue items will be filtered by the issue date rather than the
Filter Type load date.
Load Date: If selected, issue items will be filtered by the load date rather than the
issue date.
Min Amount The minimum dollar amount.
Max Amount The maximum dollar amount.

Serial Number Range  Min Serial Num Type the minimum serial number in the range

Max Serial Num Type the maximum serial number in the range.
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Issue Type Issued The check has been issued for payment.

Voided The check has been voided by maker.
Match Status Paid There was a presented item for the issued item, and it has been
paid.
Returned There was a presented item for the issued item, and it has been
returned.
Outstanding There has been no presented item for the issued item, it remains

outstanding for 180 days as a default unless specified otherwise
by your financial institution.

NOTE:

> Issuance data is available for 1 year as the default setting, but this can be
configured differently by the FI.

5. Once search criteria are selected, click Apply to narrow your search results.

6. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items, the
results will be displayed on multiple pages. Use the navigation buttons at the top of the search results to
review all results.

an Alkami Solution Team
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Item ID

Account Number

Serial Number

Account Serial
Item ID Number NMumber

The ID number associated with the specific file once an issuance file is processed and

committed to the database.

Displays the Account Number for the item.

Displays the issued item serial number.

Issue

Payee Name Type Match Status

Payee Name

Issue Type

Match Status

Displays the name of the payee for the item.

Issued The check has been issued for payment.

Voided The check has been voided by maker.

Paid There was a presented item for the issued item, and it has been paid.

Returned There was a presented item for the issued item, and it has been
returned.

Outstanding There has been no presented item for the issued item, it remains

outstanding.

Amount
Load Date/Time
Issuance Date

Update

Amount Date/Timeli Date Update

Load

[ssuance

Displays the dollar amount for the issued item.
Date and time the item was loaded.
The date of the issued item.

Click the pencil icon to update item’s Amount, Status, or Issuance Date.
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7. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The
information shown in this drop-down is an audit history of all the activity that has occurred on the issue

item.
ItemID  Account Number Serial Number Payee Name Issue Type  Match Status  Amount Load Date/Timel: Issuance Date  Update

¥ 3389966 oox1111 12304 FedEx ISSUED PAID $180.00 09/02/2021 10:44:38 EDT 059/02/2021 ®

Status Amount Issue Date Updated By Updated Date/Time

ISSUED $180.00 09/02/2021 sdelgerel 09/02/2021 10:44:38 EDT
Status Issued The check has been issued for payment.

Voided The check has been voided by maker.

Amount Displays the dollar amount for the issued item.
Issue Date The date of the issued item.
Updated By The user who updated the issue item.
Updated Date/Time The date and time this issued item was updated.

8. Modifying Issue Items.

a. Issue items can be modified by users with a Load Issue File or Manual Issue Entry privilege. Issue
items can only be modified if the match status = outstanding. Click the edit pencil button under the
Update column to update the issued item.

Account Serial Issue Load i > Issuance
ItemID Number Number Payee Name Type Match Status Amount Date/Timeli Date Update
> 2276362 wox1111 9263 Citizens Union Bank (v) ISSUED OUTSTANDING $6,130.00 05/29/2020 10:04:33  05/28/2020 a
EDT z
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9. The Update Issue Item pop-up window appears.

Update [ssue Item
Serial Number Amount Payee Name? Status Issuance Date
G263 6130 Citizens Union Bank (v} ISSUED v = | 05/29/2020
P
Save
Serial Number Check serial number. This cannot be updated on an existing issued item.
Amount Amount of the issued item. The amount can be updated.
Payee Name The name of the Payee associated with the specific issued item. The payee name can be
updated.
Status Issued The check has been issued.
Voided The check has been voided by the maker.
Issuance Date The date of the issued item. The issuance date can be updated.
10. Click Save.
Issue updated.

11. A copy of the Issue Warehouse can be downloaded by clicking the Download As CSV button at the
bottom of the Issue Warehouse screen.
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H. Item Lookup

PRO-CHEX provides Clients with the ability to look up all recorded data on individual issued items with the
Item Lookup feature.

1. Within the PRO-CHEX module, click View > ltem Lookup.

PRO-CHEX  #¥Manage ~ .« Perfor

rform ~ i Reports ~ = View ~ Change Module ~

Issue File Status

Issue Warehouse
WeICO| | Ie Transaction History
Item Looku
Pleaze yse the gbove menu to select an action [ P ]‘_

2. The ltem Lookup page appears. All fields are mandatory.

Item Lookup
Account’ Serfal Number
- not selected - b
[ oy ]
Account

Select the Account drop-down to display a list of the Client’'s Accounts.

Serial Number Enter the serial number of the item.

3. Once search criteria are selected, click Apply to complete the item lookup.
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4. Search results for the item will be displayed. Within this screen, the lifecycle of the issued item will be

displayed.

Item Loockup

Account’

The One and Only - 1111 (ASBank Client 1 - ASBC1) hd

Account Number: 301111

Transaction Date: 04-15-2021

Payment Date: 04-15-2021

Serial Number: 11548

Original Serial Number: 11548
Original Amount: $27.00

Serial Number

11548

View Check Image

Exception Reason: Amount Mismatch

Payee Match Score: Error analyzing payse name

Transaction ID: 43566 Issuance Payee Name: FedEx Disposition Created: 04/15/2021 15:00:00 EDT

Debit Amount: $27.00 Issuance Serial Number: 11548

Current Status: Pay-System Issuance Amount: $180.00

Issuance Status: ISSUED

Transaction Date: 04-15-2021 Original Serial Number: 11548 Exception Reason: Duplicate Presentment

Payment Date: 04-15-2021 Original Amount: $127.00 Payee Match Score: Error analyzing payse name

Transaction ID: 45567 Issuance Payee Name: FedEx Disposition Created: 04/15/2021 15:00:00 EDT

Debit Amount: $127.00 Issuance Serial Number: 11548

Current Status: Pay-System Issuance Amount: $180.00

Issuance Status: ISSUED

Issuance Date: 04/15/2021 Update By: mflestwood1 Payee Name: FedEx

Updated Date/Time: 04/15/2021 13:34:17 EDT Transaction Id: 45566 Match Status: PAID

Load Date/Time: 04/15/2021 13:34:17 EDT Issue Type: ISSUED Amount: $180.00
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. Other Options Prior to Item Presentment

If a Client needs to make changes to an item prior to item presentment, there are three options for doing so
within PRO-CHEX. Examples of changes that would fall under this category would be when items originally
issued are updated to Voided status, or to overwrite existing item information such as changes in amount
and/or payee.

1. Modifying Issue ltems
Issue items can be modified in the Issue Warehouse. Please refer to previous Subsection G. Issue
Warehouse, for more information.

2. Manual Re-Entry
To change individual items previously submitted, a Client user can overwrite the previous item as follows:

a. Within the PRO-CHEX Module, click Perform > Manual Issue Entry.

View - Change Module -

PRO-CHEX £ Manage ~ | # Perform « i Reports ~

Issue File Load

[ Manual Issue Entry ]1—

b. The Manual Issuance File Entry page appears. For definitions of the fields available on this screen,
please refer to Subsection C of the current Section.

Manual Issue Entry

Account? Auto populate next check number:
- not selected - b
Row Serial Number Amount Payee Name’ Status Issuance Date
1SSUED X 05/29/2020

@ Click any row to select that row for editing

Save
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c. Create a Manual Entry for the item to be changed. The serial number must match the previously
submitted item. Fill out all fields, updating the fields that need to be overwritten with the correct

information.
d. When all pertinent manual issuance files have been re-entered, click Save button.

e. The Manual Issuance File detail page appears. For definitions of the fields shown on this screen,
please refer to Subsection C of the current Section.

SEHEDEEISIET MANUAL_1614805777127

File Status

Queued Processed Approved Completed Deleted

File processing is complete, View list below to see item.

@® View itemn: 1 Item totaling $525.00 Load Date: 03/03/2021 16:09:37 EST
Rows 1 -1 of 1.
Account Number Serial Number Amount Payee Name Status Issuance Date
0003783 100945 $525.00 Moe Green AVAILABLE_FOR_MATCHING 03/03/2021
Delete

3. File Reloads

To change multiple items that were previously submitted, a Client can use the Issue File Load function to
reload and overwrite previous items in an Issue File.

a. Once you have prepared your Issue File with all items that need to be overwritten, including the
corrected information in the appropriate fields, upload the Issue File. Refer to Subsection E.
Loading Issue Files, for more information.
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4. Prior to item presentment, these changed/overwritten items can be seen in the Issue Warehouse (please
refer to Subsection G within this Section for information on how to access the Issue Warehouse).
Once within the Issue Warehouse screen, click the arrow (>) next to the Client Code to view more useful
detail on each issued item. The information shown in this drop-down is an audit history of all the activity
that has occurred on the issue item.

As you can see in the figure below, there are two issue items that have been updated/changed. The
updates/changes from the most recent entries will overwrite the previously loaded issue item.

Date Range
Issue Warehouse =
Eluly 21, 2020~
Y Filters >
30 transactions totaling $24,443.62
Rows 1 - 25 of 30.
Account Serial Issue Load : 3 Issuance
ItemID  Number Number Payee Name Type Match Status Amount Date/Timeli Date Update
v 2278BB1  xo0m3210 3464 FedEx VOIDED QUTSTANDING $26.97 07/21/2020 08:55:38  07/21/2020 ra
EDT :
Status Payee Amount Issue Date Updated By Updated Date/Time
VOIDED FedEx $26.97 07/21/2020 SallyAcme 07/21/2020 13:08:19 EDT
1SSUED FedEx $26.97 07/21/2020 SallyAcmen 07/21/2020 08:55:38 EDT
» 2278380 xox3210 3453 Office Pride ISSUED OUTSTANDING $35.00 07/21/2020 08:55:38  07/21/2020 P
EDT
WV 2278879 woox3210 3452 ABC Carpentry ISSUED OQUTSTANDING $850.00 07/21/2020 08:55:38  07/21/2020 P
EDT
Status Payee Amount Issue Date Updated By Updated Date/Time
1SSUED ABC Carpentry £850.00 07/21/2020 SallyAcme 07/21/2020 13:02:50 EDT
1SSUED ABC Carpentry £750.00 07/21/2020 SallyAcmet 07/21/2020 08:55:38 EOT
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V. EXCEPTION IDENTIFICATION

ACH Alert has partnered with Finastra to display exceptions that are identified in the Phoenix Core and
presents those items in the PRO-CHEX service module. If a financial institution is utilizing Payee Positive
Pay, ACH Alert will run all non-exception/paid items for payee processing to determine payee exceptions.
ACH Alert will not run the items that Phoenix identifies as exceptions through the payee analysis system,
since they were already identified in the core.

‘ Exception Exception Reason Description
Reason Code
-51347 The item was rejected due to duplicate serial number.
-51343 The item was rejected because the issued amount does not equal the posted amount and the recon account is
configured for a no variance allowed.
-51342 The item was rejected because it has a status of posted.
-51341 This serial number cannot be used as it already exists.
-51340 The item was rejected because it has a status of void.
-51339 The item was rejected because it has a status of stop pay.
-51338 The item was rejected because it has a status of stale.
-51337 The item was rejected because it has a status of matched.
-51336 The item was rejected because it has a status of issued, re-issued, or returned.
-51335 The system could not update one or more fields on this account’s recon record.
-51334 The item was rejected because it does not match the issued amount or fall within the variance of the ...
-51332 Posted amount cannot vary from issued amount.
-51329 No issued record exists for this recon deposit item and the account does not allow posting without an issued item.
-51328 No issued record exists for this recon deposit item and the account does not allow posting without an issued item.
-51314 The item was rejected because it has a status of stop pay.
-51313 The item was rejected because it has a status of matched.
-51312 The item was rejected because the serial number is blank.
-51310 The system could not delete one or more fields on this accounts deposit account recon record.
-51309 The item was rejected because it has a status of stale.
-51308 The item was rejected because it has a status of void.
-51307 The item was rejected because the recon variance type has not been configured correctly.
-51306 The item was rejected because it does not match the issued amount or fall within the variance of the issued
amount.
-51305 The Recon item was rejected because the Tran Code posted does not use Recon.
-51304 The item was rejected because it has an unauthorized serial number.
-51303 This account has more than one recon item record.
-51302 The system could not retrieve a recon item for this serial number.
-51301 The system could not insert a deposit account recon record for this account.
-51300 The system could not update one or more fields on this accounts deposit account recon record.

EXCEPTION_RE | The exception reason present in the file does not exist in CP_EXCEPTION_REASON_TBL.
ASON_MISSING

ISSUANCE_PAY | Payee Discrepancy
EE_MISMATCH
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VI. MANAGING CHECK PRESENTMENT

The primary objective of PRO-CHEX is to give users the opportunity to make pay and/or return decisions on
checks presented for payment on accounts enrolled for the service. The decision function is performed in the
Transaction History screen.

NOTE:

» Transactions are stored for 12 months.

» The Transaction History user privilege must be enabled to access this screen.

» If the user has been granted the Change Status user privilege and the transaction is
available to decision, the Pay and Return buttons will be available for use.

» Transactions that will be paid will have green shading as a background.

» Transactions that will be returned will have yellow shading as a background.

» Transaction status cannot be changed after the EOD cut-off time.

PRO-CHEX provides a function for Clients to search and view the status of checks presented on
enrolled accounts, and to make decisions on presented items. Client users can use Transaction
History to search for presented check items for a specific account using one of the many filtering
options available. It is important to note that the default filter setting is Exceptions Only. Additional
transactions may be available to view and decision (such as reverse positive pay items); however,
this will not be displayed unless the Exception filters option is set to Show All Transactions.
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1. View Transaction History

a. Within the PRO-CHEX module, click View > Transaction History. The Transaction History page will
display all current day transactions for all accounts to which the user has access.

; y Date Range
Transaction History 2

Eseptember 2, 2021~

Y Filters b3

1
Transaction ID Account Number Serial Number Credit Debit Current Status Dateli Change Status Exception

> 49194 2001111 12334 $127.00 Pay-System 09-02-2021 i ® Return ) 2]
> 49193 001111 @ $27.00 Pay-System 09-02-2021 ® Return 2]

> 49192 2001111 12333 $35.10 Pay-System 09-02-2021 ® Return ]

Transaction ID Unique ID assigned by the PRO-CHEX system when transactions are loaded.
Account Number Account number the check was presented against.
Serial Number The check number presented for payment.

Clicking on the serial number will display the front and back images of the check. If an eye
icon appears in the serial number column, this denotes an item that was processed with no
serial number. Clicking on the eye icon will display the check image, if available.

Credit This column will display if deposit information has been entered into the system.
Debit This column displays checks.
Current Status Pay Pay-System The system is set to default pay this check.
Pay-FI The check was paid by the FI.
Pay-User The check was paid by the Client User.
Return Return-System The system is set to default return this check.
Return-Fl The check was returned by the FI.
Return-User The check was returned by the Client User.
Date Date the check was presented for payment or loaded to PRO-CHEX.
Change Status If the user has been granted the Change Status user privilege and the transaction is eligible

for a decision, a Pay or Return button will appear for use. If the transaction is not eligible for a
decision, the button will display as ineligible.

Exception If the transaction is an exception, an exception identifier will appear in this column.

an Alkami Solution Team
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b. To filter the date range of items shown, click on the Date Range drop-down.

. " Date Range
Transaction History i .
EESeptember 2, 2021~

Tomorrow

45 debit transactions totaling $34.89

Yesterday

Rows 1-25 of 45,

Last 7 Days

n AR This Month

Last Maonth

z Custom Rang
Transaction ID Account Number Serial Number Credit Debit Current Status Datel Change EEEIIREHE

F Cancel
> 49194 XXxx1111 12334 $127.00 Pay-System 09-02-2021 - R

c. To narrow the search results, click Filters and a window containing additional search criteria will
appear.

" 3 Date Range
Transaction History i =
EEMarch 4, 2021~

Y Filtars v
Account’ Serial Number Items
- not selected - w Any Ttems w
Min Amount Serial Number Range Transaction Status
| [ — Min Serial Num Max Serial Num Pay
Max Amount
g i T smount Exceptions
Show All Transactions ad Return-System
Return-FI
Default Return-
ect multiple status
Account Type an account name or the last 4 digits of the account number into the field to view transactions
for one specific account or select an account from the drop-down menu.
Min Amount Type the minimum check amount into the field.
Max Amount Type the maximum check amount into the field.
Serial Number Type the check serial number for a single transaction. A serial number range can also be defined
by entering the minimum and maximum serial number.
ACH ME Version 2.0.7 rev 4
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Exceptions The user may select from the drop-down to filter by one of the following:

» Exceptions Only
» No Exceptions

The default will be set to “Show All Transactions”; however, the user can click the “Default”
checkbox to select a different option to be the default for future filtering.

ltems Defaults to Any Items. This includes all items.
Transaction Pay Pay-System The system is set to default pay this check. If a user takes no action
Status before EOD, the check will pay.

Pay-FI The check was paid by the FI.

Pay-User A user changed the transaction status from a Return to a Pay status.

Return Return-System  The system is set to default return this check. If the user takes no
action before EOD, the check will be returned.

Return-Fl The check was returned by the FI.

Return-User A user changed the transaction status from a Pay to a Return status.

d. Once search criteria are selected, click Apply to narrow your search results.

e. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items,
the results will be displayed on multiple pages. Use the navigation buttons at the top of the search
results to review all results.

45 debit transactions totaling $34.896.60

Rows 1 - 25 of 45.

f.  Summary Debit and/or Credit transaction totals are also displayed at the top of the screen above the
navigation buttons.

P2

3,859 debit transactions totaling $16,010

150 credit transactions totaling $194,496.50

Rows 1 - 25 of 4,009.
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g. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The
information shown in this drop-down is an audit history of all the activity that has occurred on the

issue item.

Transaction History

Y Filters

Transaction ID

W 4gig4 xxxx 1111 12334

Paositive Pay Type: standard
Issuance Serial Number: 12334
Issuance Amount: $180.00
Issuance Date: 09-02-2021
Original Serial Mumber: 12334

Original Amount: $127.00

¥ 49193 w00t 11

Positive Pay Type: standard
Issuance Serial Number: 12334
Issuance Amount: $180.00
Issuance Date: 09-02-2021
Original Serial Number: 12334

Original Amount: $27.00
¥ 49192

Paositive Pay Type: standard
Issuance Serial Number: 12333
Issuance Amount: $750.00
Issuance Date; 09-02-2021
Original Serial Number: 12333

Original Amount: $35.10

Return Date: 09/02/2021 16:00:00 EDT
Return Reason: Amount Incorrect

Loaded Exception Reason: Amount Mismatch

Date Range

i_snuar}' 1, 2021 - September 2, 2021 =

?
z
Account Number Serial Number Debit Current Status Dateli Change Status Exception
£127.00  Pay-System 09-02-2021 o
Payment Date: 09-02-2021
Loaded Exception Reason: Duplicate Presentment
334 $27.00  Pay-System 09-02-2021 e
Payment Date: 09-02-2021
Loaded Exception Reason: Amount Mismatch
001111 12333 $35.10 Return-User 05-02-2021 -]

Positive Payee Type

Issuance Payee Name
Issuance Serial Number
Issuance Amount
Issuance Date

Original Serial Number

Original Amount

ACH AI.EI‘I
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This indicates the type of positive pay that the account is set for:
Standard, Reverse and Payee are the different types that could display here.

Name of payee submitted with the transaction presented for payment.
Serial number on the issued item uploaded by the client.

Amount on the issued item uploaded by the client.

Date the issued item uploaded by the client.

Serial number submitted with the transaction presented for payment.

Amount submitted with the transaction presented for payment. This number may be
different than what is displayed in the top line.

Version 2.0.7 rev 4
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Return Date Date the item was returned.

Payment Date Date listed within the transaction file.

Return Reason Reason for return.

Loaded Exception This user documentation displays the standard exception reason labels.
Reason

Please refer to Section V. Exception Identification to view a list of all standard
exception labels.

Payee Match Score Payee scoring is addressed in the account configuration screen. The score displayed
here is the score that was assigned by the payee analysis engine when the payee name
on the check was compared to the payee name provided on the issue item.

2. Change Transaction Status
a. Ifthe user has been granted the Change Status user privilege and the transaction is eligible for a
decision, a Pay or Return button will appear for use. If the transaction is not eligible for a decision, the
button will display as ineligible.

3. Change Status — Pay

a. If the Current Status on an issued item is set to Return, the Client can opt to change the status to Pay
if the Client determines the check should be paid.

b. Click the Pay button under the Change Status column.

ransaction ID Account Number Serial Number Credit Debit Current Status DatELI Change Status Exception

» 14454 wood 111 ESE0 25,130.00  Return-User 03-18-2020 m

The Change Status button will then change to Return, and the Current Status column will update to
“Pay-User.”

4. Change Status — Return

a. If the Current Status on an issued item is set to Pay, the Client can opt to change the status to Return
if the Client determines the check should not be paid.

b. Click the Return button under the Change Status column.

> 14463 wox1111 B57S 52400  Pay-System 03-18-2020 @ Return
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c. Check Return Reason pop-up window appears. Select the appropriate reason for the Check Return.
Please note that the list of return reasons displayed are the system default but may vary depending
on the way the financial institution defines them.

Select a check return reason:

 Stale Dated

' Post Dated

C Endorsement Missing

' Endorsement Irregular

(O Requires Two Signatures or Signature Missing
_) Signature Irregular

 Altered/Fictitious [temn or Mutilated

' Not Authorized

C Refer to Maker

© Cannot Determine Amount

' Duplicate Presentment

C Forgery
G Stale Dated
H Post Dated
| Endorsement Missing
J Endorsement Irregular
K Requires Two Signatures or Signature Missing
L Signature Irregular
N Altered/Fictitious Item or Mutilated
Q Not Authorized
S Refer to Maker
w Cannot Determine Amount
Y Duplicate Presentment
Y4 Forgery
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d. Click Save.

Check will be returned

e. The Change Status button will then change to Pay, and the Current Status column will update to
Return-User.”

5. A copy of the Transaction History can be downloaded by clicking the Download As CSV button at the
bottom of the Transaction History screen.

1. Confirm Paying Exceptions (May or may not be implemented by the FI)

a. When the first exception is triggered on a presented item, additional validations are not performed. If
the system detects a user pay decision on a check that additional validations were not performed
(such as payee name analysis which is the last validation to occur), an image of the check will be
presented to allow the user to visually inspect the check. The user must click the confirm button to
finalize the pay decision.

b. If the user decides to pay an item that is set to return, they will be presented with a pop-up window to
confirm that this is the action they wish to take. The window will display an image of the check and
other details for the user to review before confirming that they want to pay the item.
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i.  Click Pay to pay a check.

Confirm Check

Exception Reason: Check presented where amount of check differs from issue amount

Issuance Serial Number: 152 Issuance Amount: $75.75

‘ Cancel | Confirm

Check amount and serial number may be adjusted after Confirm

1) A pop-up window with check information will display for the user’s review.

2) Once the user has reviewed the information presented, they can decide to Confirm so that the
check will be paid or to Cancel so that the check will be returned.
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VIl. REPORTS

NOTE:

> Reports are available for one (1) year.

A. Issue Item Status Report

NOTE:

» The Issue Item Status Report user privilege must be enabled.

1. Within the PRO-CHEX Module, click Reports > Issue Iltem Status.

PRO-CHEX ¥ Manage = # Perform = i Reports = View = Change Module «

[ 1Issueltem Status |em——
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2. The Issue Item Status Report page appears. The page will default to Outstanding items but can be
changed to Paid items or Returned items.

Issue Item Status
Izsue Item Status

Issuance Status Start Date End Date

. = to Se = | 10/28/2020
® Qutstanding

O paid

I Summary Information Only Account’
O Returned
O Stops/Voids -not selected - ~
Issuance Status Outstanding Any items that have not been matched and decisioned yet.
Paid Any items that have been matched and paid.
Returned Any items that have been matched and returned.
Stops/Voids Any items that have a stopped/voided status.
Start Date The start date is only applicable when filtering by Paid or Returned Issuance Status.
End Date The end date will default to the current date.
Summary Information Will show summary, rather than detailed, information on the displayed data.
Only
Account To further narrow down the results the report can be filtered by a specific account.

3. Once search criteria are selected, click Apply to narrow your search results.

4. Search results are displayed in pages of 25 items. If the search contains more than 25 transactions, the
results will be displayed on multiple pages. Use the navigation buttons at the top of the search results to
review all results.
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5. The Issue Item Status report will populate below the search window.

Account Number Serial Number Payee Name Amount Issuance Date
ool 111 9263 Citizens Union Bank (v} $6,130.00 05/28/2020
o0ocd111 5262 Advanced Medical, Inc. $24.00 05/28/2020
oo 111 9261 Richard Canova $53.36 0542872020
oo 111 9259 Waller Lansden Dortch & Davis, LLP $933.00 05/28/2020
wood 111 9258 Richard Canova 51.00  05/28/2020
o111 9257 Office Pride $260.00 05/28/2020
o111 9256 Jonathan Copeland 2600.00  05/28/2020
ool 111 9255 Cisco Webex, LLC £65.55  05/28/2020

Account Number Displays the masked account number.

Serial Number Displays the serial number for the item.

Payee Name Displays the payee name, if applicable.
Amount Displays the amount of the issuance item.

Issuance Date Displays the date of the issuance item.

Payment Date Displays the payment date of the item.

Return Date Displays the return date of the item.
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6. If the Summary Information Only checkbox was selected, the Issue Item Status report will populate with
summary information as shown in the graphic below.

Account Number

w1111

Account Mame Check Status Total Items Total Dollar Amount

WHKP Main Qurstanding Issued Items 281 $267,978.96
WP Payroll Questanding Issued Items T $9,311.83
WEP Expense Ourstanding Issued Items 3 51,464.75

Grand Total: 5278,755.64

Account Number

Account Name

Check Status

Total Iltems

Total Dollar Amount

Grand Total

Displays the masked account number.
Displays the name of the account.
Displays the status of the issued items.

Displays the total amount of items with a particular check status for a specific
account.

Displays the total dollar amount of all items in the row.

Displays the grand total dollar amount of all items displayed in the rows above.

7. The entire Issue Item Status Report can be downloaded as a CSV file (Comma Separated Value). Click
on the Download as CSV button at the bottom left of the Issue Item Status Report screen.
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VIIl. PAYEE POSITIVE PAY TIPS & BEST PRACTICES

For client users to have the best user experience possible, we have outlined some best practices to help
make the onboarding process more efficient.

E

A. Payee Name Comparison: “Scoring”

PRO-CHEX payee name scoring can reasonably handle a variety of check styles, fonts, and even hand-
written names on a payee line. However, it is important to note that scoring does not indicate with 100%
certainty if the payee name on a check matches the payee name provided with the issue item information.

The technology scores on the likelihood of a match and will fail or pass an item based on the scoring
threshold set. The system supports a range of 0-1000. The lower the threshold is set, the more likely it is
that fraudulent items will pass. The higher the threshold is set, the less likely they are to pass, but the flipside
is items where there is an exact match could trigger unnecessary exceptions.

PRO-CHEX default threshold is set at 500. This is not a recommendation by ACH Alert, it is simply a system
default that each financial institution can have raised or lowered based on their risk tolerance. In addition to
establishing a global scoring threshold, FI's can customize the default on an account by account basis.

Each institution should consider incorporating language into their client agreements to explain that payee
comparison is a scoring methodology that can be impacted by a variety of factors and therefore, as their
financial institution, you make no representations or warranties that the technology is going to score items
correctly each and every time.

FI's can help their clients reduce the number of false exceptions by recommending they use the best possible
check design and formats as outlined in the best practices below.
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Customers will find the most success following these suggestions in their check designs and format.

e Paper weight should be 24” MICRBond (to ensure better image quality when physically captured with
reader).

e Use check stock with no backgrounds or lighter colored backgrounds and no logos or marks in the
payee field. Any background patterns, images or watermarks on the check stock that is within the
area of the data to be recognized can interfere with recognition results. [Please refer to Figures 1.1
and 1.2 at the end of this subsection for good and bad examples]

e Check stock should be consistent for each account.

e  Minimum 200 dpi resolution required; 600 dpi or higher resolution preferred.

e Printing with an ink jet or laser printer will produce best results.

e Check printing should be consistent with the payee information in the same location per account.

e Checks should be fixed width (fixed spacing) 10-point font or higher for the Payee Block and Amount.
Font size 12 or 14 will produce best results. [Please refer to Figures 1.3 and 1.4 at the end of this
subsection for good and bad examples]

e Sans Serif fonts are preferred (no bold). For example, Courier New, Courier, Lucida Console,
Terminal, Letter Gothic are all acceptable fonts. Courier New is preferable. [Please refer to Figures
1.3 and 1.4 at the end of this subsection for good and bad examples]

o “PAY TO THE ORDER OF” should not be italicized or underlined and must be printed horizontally at
the same level to the left of the payee name. Payee Name should be printed to the right of “PAY TO
THE ORDER OF” starting from the position of the keyboard “PAY” or lower. [Please refer to Figures
1.5 and 1.6 at the end of this subsection for good and bad examples]

o Payee name should be a maximum of 100 characters, left aligned and single line spacing should be
used. [Please refer to Figures 1.7 and 1.8 at the end of this subsection for good and bad
examples]

e Up to four payee names are permitted. [For more information about multiple payee handling,
please refer to Subsection D, Multiple Payee Handling, within this section]

e The payee name and amount should be surrounded by an area of white space, minimum of 2 empty
lines. This will minimize the interference of any irrelevant printed information on the item and allow for
some shifting/offset of the data’s location during the scanning process. [Please refer to Figures 1.7
and 1.8 at the end of this subsection for good and bad examples]
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e Payee name should not be italicized, bolded or underlined and words should be separated by one (1)
single blank space. [Please refer to Figures 1.7 and 1.8 at the end of this subsection for good
and bad examples]

o Payee Name should be printed only once on the check, within the Payee Block. Do not split the
Payee Block into two non-adjacent parts (the Name and the Address). [Please refer to Figures 1.7
and 1.8 at the end of this subsection for good and bad examples]

o Uppercase characters will produce best results. [Please refer to Figures 1.7 and 1.8 at the end of
this subsection for good and bad examples]
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Figure 1.1

Good Example: A check stock that is light colored, with no logos in the payee field.

| Client X¥Z My Bank Mo 1012

: 123 First Strect 123 Bank Road 41-Takad

| Louisville, KY 40212

I (502} 123 1234 Date 1001172016

| PayToTh .

| Orderof . ABC Baby Store o = s S *4200.00

| Two Hundred and G0/ 100 W e Byl EMARER 1Y v S WP P Dollars

| Tl MR N

i

| Memo: For purchase order #1234 Fre-approved Check - No Signature Required

! o =T s
#OoODOo MO L id3L5E7890L2ILER7EqE

Figure 1.2

Bad Example: A check with a background that is too dark and may cause issues when scanning.

ABC Company 1001
123 Main Street

Cityville, ZA 00000 Date: 03/01/2019

*00000M0 &2 K 23L5678900423L56789"
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Fiqure 1.3

Good Example: Payee Block and Amount use fixed width spacing, 12-14 font size sans serif fonts.

ABC Company
123 Main Street

Cityyille, ZA 00000

Amount:| FIVE THOUSAND THREE HUNDRED AND 29/100

Payto thk orderof: MARKIV SERVICES
505 ROAN STREET

MAINVILLE, ZA 00000

Mema: Consulting Services %Cbm-LL =& E‘-{wnﬁm

1001

Date: 03/01/2019

S 5300.29

®*000004W0 e K L23L,5678910L23L56789

Figure 1.4

Bad Example: Serif font is used, non-fixed-width spacing and bolded font that is less than a 12-14 font size.

ABC Company
123 Main Sireet

ifyville. ZA 00000

Amomi: Five Thonsand Three Hundred and 29/100

Mark IV Services
Pay to the 505 Roan Street
order of Mamville. Z4 00000
Memo: Consulting Services @amuel & antlin

$ 530029

1001

Date: 03/01/2019

0000002 KL 23LSET7B9N0L23ILSE789"
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Figure 1.5

Good Example: “Pay to the Order Of’ is horizontally printed at the same level as the payee name. The font is not
italicized or underlined.

ABC Company
123 Main Street 1001 :
Cityville, ZA 00000

Date: 03/01/2019
Amount: | F|VE THOUSAND THREE HUNDRED AND 29/100 $ 5300.29

Pay to the order of: | MARK IV SERVICES
505 ROAN STREET
MAINVILLE, 74 00000

Memao: Consulting Services “Q_:)WLJ: gmnmm

00000 D& LL23L5678900L23L56789"

Figure 1.6

Bad Example: “To The Order Of’ appears instead of “Pay To The Order Of” and is not horizontally printed next to the
Payee Block. The font is italicized.

ABC Company 1001
123 Main Street : s
Cityville, ZA 00000 /012015

*00000 M0 k2" 1X323L5678910L23L5E789
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Fiqure 1.7

Good Example: Payee name and amount surrounded by an area of white space. Payee name is left aligned and
single spaced. Payee name printed in uppercase letters, and is not italicized, bolded or underlined. The payee name

is not split into non-adjacent parts and printed only once on the check.

ABC Company
123 Main Street

Cityville, ZA 00000

Amount: | F|VE THOUSAND THREE HUNDRED AND 29/100

Pay to the order of!

MARK IV SERVICES
505 ROAN STREET
MAINVILLE, ZA 00000

Meme: Consulting Services

Mammas mrim =y s

Figure 1.8

Bad Example: Payee name not surrounded by white space. Font is bolded and upper and lowercase letters are

(35 IR a3
Samuel Fzanklin

Date: 03/01/2019 |

$ 5300.29

®*000004W0 e K L23L,5678910L23L56789

used in the payee block. Payee name is in a separate area than the payee address and therefore is not left aligned.

ABC Company
123 Main Street

Cityville. ZA 00000

Amamnt: Five Thousand Three Hundred and 29/100

Pav to the Mark IV Services 305 Romn Sireet

order of

Wainyille. 24 00000

Memo: Consulting Services

All!:IIJl\IJEI‘F'
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(35 IR a0
S amuel Franklin

$ 530029

Date: 03/01/2019 |

*D0000&0O 2™ 132345678900 23L56789"
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Following are some examples of check formats which cause processing errors and issues with payee

scoring.

Bad Scans & Poor Image Quality

Poor image quality can interfere with scans.

It appears the check paper was inserted into the printer improperly, causing the payee name
information to print in a blurred/slanted condition and therefore cause issues with scanning. [Payor

name, Payee name and bank name partially removed for confidentiality]

WTTH Larr S hEs & BoRFE
ovooon |
P CAcg HE L P " ok Rk |
Sevein hurthed aighty roop el Y00 Dty 198000 " oo0m0oe000 bty |
0 The Bamsipn 1)
denge Y IERICAaN |
| 0y S R i |
ROLKVILLE, r:tt:;.!i?ém P !
] m‘
e = |
| ALTROACED BoraTire |
*30000J0000* 0o00000a0:: 0000000000 00000 TE
i eTd

Poor Image Quality. Payee area only states “To the Order of” and is not horizontally printed. The
boxes around date and amount might cause issues with scanning.

jhevck'# ’20057]’46 .
Check Amount ‘
ek g1788.54

period 04/26/2020

;éa,c;k/ Date
/11/2020 -

s
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Poor image quality. Check fields are in non-serif fonts. Boxes around check fields may cause issues
with scanning. Pay To The Order Of is not horizontally printed.

b

PAYROLL ACCOUNT .
f : = N ” :
[ 06758 3931.0000 | 10573 06/03/20 $920.34 1
: Creck Ws. Co.1D” Decartrart 1D Number Socisl Secunty Number | Pay Date Net Pay

Pay Thas Amount

;'
- **xxxx2exxx**NINE HUNDRED TWENTY DOLLARS & 34 CENTS*#**atsszriax,

-

Acme Commercial Bank

PAY  \ARK LEWIS
ToThe 937 Ridge Road
O(rsﬂfef Franklin, ZA 00000
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PRO-CHEX has the ability to support customers with multiple payee names on issued items. PRO-CHEX
can score multiple names on a check against information provided in the issuance file. Multiple payees
can be listed on a single line, or on two separate lines on the check. Examples of correct formatting are

shown below.

_ — — = e
ABC Company Z
123 Main Street 1001 i
Cityville, ZA 00000 f

Date: 03/01/2019 |
Pay to the : f
orderof  Elaine Archeron and Nesta Archeron $5300.29
Five Thousand Three Hundred and 29/100 Dollars
Meihis, Coostipg samices Sl il

®*00000M02" K L23L5E78910L23L56789"
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ABC Company
123 Main Street

Cityville, ZA 00000

Pay to the Elaine Archeron
order of Nesta Archeron

1001

Date: 03/01/2019

$5300.29

Five Thousand Three Hundred and 29/100

Dollars

Memo: Consulting Services éanmmf 3WM“_

*00000M0 2™ K L23L5E789K0L23L 56789

1
|
|
|
|}
]
1
|
|
|
|
|
|

1
1

ABC Company
123 Main Street

Cityville, ZA 00000

Amount: FIVE THOUSAND THREE HUNDRED AND 29/100

MARK IV SERVICES
ABC COMPANY

505 ROAN STREET
MAINVILLE, ZA 00000

Pay to the order of:

Memo: Consulting Services g) e

1001

Date: 03/01/2019 |

$_.5300.29

*0000040 L2 KL 23L56789104L23L56789"
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1. This section is designed to explain how to handle multiple payee names that will appear on two separate
lines of the check.

a. Multiple Payee Handling setup in Issue Templates.

i.  The Multi-Line Payee Name Separator field is included in the Issue Template creation screen
that allows for recognition and recording of multiple payees on a check.

Create New Template

Template Name File Type’ Template 5tatus

- select file type b Active ha

Template Level’

FI w

Number of Header Rows’ Number of Footer rows’

0 0

Muiti-Line Payee Name Separator: ¥

Do not use a character as a separator if

that character will ever be present ina
Payee Mame. Allowed characters in
brackets[; | .-_/]

ii. This feature allows the Fl or Client user to enter a character into the field that can be used to
separate Multiple Payee Names that are on separate lines of an issued item. Currently, the

system restricts the allowed characters to the following: ; | y < | . The user must be aware that

using a separator character that appears elsewhere in the payee name or might conflict with the
file itself can cause issues. Examples of scenarios where problems might arise are listed below.

Within a Comma Separated file (.csv), different data fields are separated by a comma. It is
important to note that a comma cannot be used in the data field itself, or the .csv will read the
comma as a separator before the next field. Therefore, listing two payees for an item in this way:
“Elain Archeron,Nesta Archeron” will cause issues reading the .csv file. In this scenario, the user
should select a multi-line payee name separator character that will not cause an issue, such as a
semicolon. “Elain Archeron;Nesta Archeron” in the Payee Name field of the .csv file will process
correctly.

If the user selects a separator character that would ever appear in a payee name field, such as a
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dash (-), the system would then separate the data before and after the character as separate
payees. For instance, if the user has selected a dash (-) as the Multi-Line Payee Name
Separator, and a common payee used is “In-and-Out Burger”, the system will flag this as having
multiple payees. In this case, the user should select a multi-line payee name separator that will
not cause such issues, such as a pipe (|) or a semicolon for cases of multiple payee names.

b. Multiple Payee Handling in Manual Issue Entry.

i.  When the Client user performs Manual Issue Entry, the Payee Name field supports up to four
Payees. When in the Manual Issue Entry screen, the names should be listed as shown below. An
Enter (carriage return) must be used to input the second, third or fourth payee on separate lines
in the field for it to be distinguished as different payees. Example of Manual Issue Entry and
corresponding issue item below:

Manual Issue Entry

Account’ Auto populate next check number:

The One and Only - 00x1111 v

Row Serial Number Amount Payee Name? Status Issuance Date

12345 5000.00 Nesta Archeron ISSUED ¥ & | 01/18/2022
Elain Archeron

ABC Company
123 Main Street 12345

Cityyille, ZA 00000 |
Date: 01/18/2022 |

Amount: F|VE THOUSAND AND 00/100 S 5000.00

Payto the order of:  nesta Archeron
Elain Archeron

Memo: Consulting Services S amel Fanbelin

*000004&0 k2™ 1K1 23L5E78910423L 56789
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ii.  If the multiple payees are listed on a single line of the check, putting the names on separate lines
is not applicable. Example of Manual Issue Entry and corresponding issue item below:

Manual Issue Entry
Account’ Auto populate next check number:
clear
Row Serial Number Amount Payee Name’ Status Issuance Date
1710 26000 MNate Archeron and Nesta Archeron ISSUED W -] 06/30/2020
#

ABC Company 1710 :
123 Main Street f
Cityyille, ZA 00000 :

Date: 06/30/2020 |

Amount: TWENTY-SIX THOUSAND AND 00/100 $.26000.00

Payto the orderof: paie Archeron and Nesta Archeron

Memo: Consulting Services R

*00000 D2 XL23L567890L23L5E 789"

iii. Itis important to note that the Payee Name field currently supports 100 characters in total.
This character limit includes the carriage returns separating multiple payees. The 100-
character limit is for the entire field, and not per payee.

Manual Issue Entry is covered in depth in the PRO-CHEX Client User Guide. Please refer to
this document for more general information about Manual Issue Entry.

c. Multiple Payee Handling when Loading Issue Files.

i.  When the Client user loads issue files to the system, the loaded file is processed with an Issue
Template set up within PRO-CHEX. The Issue Template allows for selection of a Multi-Line
Payee Separator, a character chosen to separate the names of multiple payees in the issue file.

ii.  If multiple payees are listed on a single line of a check, no action needs to be taken.
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iii.  If multiple payees are listed on two or more separate lines on a check, the multiple payee
separator character (which should match the one designated in the template), must be used
between each name. Example of an issue file and corresponding issue item below:

A | B & D E F

1 _ Num . Date Name Account Original Amount Status

2 {

3 {

4 r'1 13116 | 11/09/2021 Cisco Webex, LLC 1357913579 $65.55 ISSUED

3 "'1131'1? . 11/09/2021| Jonathan Copeland | Michael Copeland 1357913579 $600.00 155UED

i} ,,"1131'13 | 11/09/2021 Office Pride 1357913579 §260.00 15SUED

[ "1131'19 | 11/08/2021 Richard Canova 1357913579 $30.00 ISSUED

8 ,"'1'13'120 | 11/09/2021 Waller Lansden Dortch & Davis, LLP 1357913579 $933.00 ISSUED

g "'1131 1 | 11/0972021 Advanced Medical 1357113579 $24.00 ISSUED

10 ;"'113122 . 11/09/2021 Citizens Union Bank 1357913579 $6,130.00 ISSUED

11 "'1 13123 | 11/09/2021 Covey Seminars 1357913579 $53.36 ISSUED

12 r'1 13124 | 11/09/2021 Cuyahoga County Clerk 1357913579 $193.93 1S5UED

13 "'1 13125 | 11/0972021 Michael Farrell 1357913579 $2,800.00 ISSUED

14 _,"113126 | 11/09/2021 Nesta Archeron | Elain Archeron 1357913579 $150.00 ISSUED

15 "1 13127 | 11/09/2021 Jake Chambers 1367913579 $150.00 ISSUED

16 ,"1 13128 | 11/09/2021 ABC Carpentry 1357913579 §750.00 1SSUED

17 "1 13129 | 11/09/2021 FedEx 1357913579 $180.00 15SUED

13 "'1 13130 | 11/09/2021 UPS 1357913579 $90.00 ISSUED
ABC Company ;
123 Main Street 113117 |
Cityville, ZA 00000

Date: 11/09/2021 |
Amount: S|X HUNDRED AND 00/100 $ 600.00

Pay to the orderof:  5nathan Copeland
Michael Copeland

: : = 5T 1A
Memo: Consulting Services R e e o TR

*00000 02" K23L567890423L56789

Loading Issue Files is covered in depth in the PRO-CHEX Client User Guide. Please refer
to this document for more general information about Loading Issue Files.
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d. Things to Remember: Multiple Payee Name Separators.

To recap the information covered above, remember:

i.  The Multi-Line Payee Name Separator character designated in the Issue Template must match
what is used in the Issue Files loaded to the system. The system will recognize that character and
when encountered in an Issue File, will record the data appearing after that character as a
separate payee.

i.  The allowable characters are: ; | , = _/ .

iii.  Some characters may cause problems when used as a separator. Do not use a character as a
separator if that character will ever be present in a Payee Name, or is a character used in a
specific file type (i.e., Comma Separated files).

iv.  Payee Name Separators are only necessary when payee names are listed on two or more
separate lines of a check.
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IX. PREFERENCES

A. Preferences

1. From within the Dashboard or PRO-CHEX Module, click User's Name > Preferences.

PRO-CHEX £} Manage ~  # Perform = JdiReports » Eview Change Module ~ & Tom Jones -
o Client 3
T —
O Logout
Please use the above menu to select an action

2. The Preferences page appears.

Preferences
Default Pages

Default Module

- select - v

Default PRO-CHEX Page

- default - v

Default Dashboard Page

- default - Y

Save

3. Default Module gives the User the ability to choose the default landing page.

Preferences
Default Pages

Default Module

-select - v

PRO-CHEX
Dashboard
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4. Default PRO-CHEX Page allows the user to select the default landing page within PRO-CHEX.

Preferences
Default Pages

Default Module

PRO-CHEX v

Default PRO-CHEX Page

- default - v

Manage / Additional Issue Fields
Manage / Issue Templates
Perform / Issue File Load
Perform / Manual Issue Entry
Reports / Issue Item Status

Reports / Scheduled
View / Issue File Status
View / Issue Warehouse

View / Item Lookup
View / Transaction History

5. Default Dashboard Page allows the user to select the default landing page within the Client Dashboard.

Preferences

Default Pages

Default Module

PRO-CHEX b

Default PRO-CHEX Page

- default - v

Default Dashboard Page

; - default - ~

Manage Users

Reports / Audit Report
Reports / Notification Delivery Report

Transaction View

6. Once any preferences have been selected, click Save to update the settings.

Preferences

Preferences Saved
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APPENDIX A — MESSAGE ALERTS

Service Alert Type Description Recipient

Module

PRO-CHEX CP Send Issuance Load Alert If Fl is sending issue files to ACH Alert on Fl &
Failure behalf of Clients, this alert is sent to users with | Client

the system alerts flag enabled when an issue
file fails to load properly. If the FI has enabled
this feature for Clients, this alert will be sent to
Clients with the issue load alerts privilege
enabled when an issue file loaded through the
Client portal has issues that prevent it from
loading successfully.

CP Send Issuance Load Alert If Fl is sending issue files to ACH Alert on Fl &
Success Fl behalf of Clients, this alert is sent to users with | Client
the system alerts flag enabled when an issue

file loads properly. If the FI has enabled this

feature for Clients, this alert will be sent to

Clients with the issue load alerts privilege

enabled when an issue file loaded through the

Client portal loads successfully.

CP Acct All An alert per account sent to users for Client
exceptions and any matched items.

CP Acct Exceptions An alert per account when one or more Client
exceptions exist that require a decision.

CP EOD Reminder This alert will be sent to Client users with the Client
change transaction status user privilege if

exceptions exist and a user with change

transaction status has not logged into the

system at the FI's designated time. This alert

option will only be available if enabled by the

financial institution.

If alert method for PROCHEX is set to “None”
for a Client User, they will not receive the EOD

reminder alert.
CP TRX All An alert per check transaction. Client
CP TRX Exception An alert set per transaction deemed an Client

exception by the system.
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APPENDIX B — QUICKBOOKS ISSUE FILE EXPORT

This guide is meant to aid client users in exporting check file data from QuickBooks. There are two methods
of exporting the check file data from QuickBooks. Both options are outlined below. These examples are from

the QuickBooks desktop version. The first option is using a Quick Report from the checking account. The
second method is using the Check Detail Report, which requires more actions for the user to take.

A. Exporting from QuickBooks Account Register

1. From QuickBooks, use Ctrl+A to open the account listing from any screen.

2. Click once to select the appropriate account to pull the Check File.

Castlerock Leasing, LLC. - QuickBooks Desktop Pro 2017 - [Chart of Accounts]

= File Edit View Lists Favorites Company Customers Vendors Employees Banking Reports Window Help Special Offers

§ : TYPE BALANGE TOTAL
I T

ol . \illennium Bank Bank 14,833.33
+ Accounts Receivable Accounts Receivable -322,118.58
«Loans Receivable Other Current Asset 0.00
+ Inventory Asset Other Current Asset 0.00

Jill « Undeposited Funds Other Current Asset 0.00

g + 202 Summitt Street Fixed Asset 46,297.06

g « 102 Mcafee Road FixedAsset -7.896.34

: + 6543 Olde Landing Lane Fixed Asset 114,191.81

= «Land FixedAsset 161,248.17

3. Once the Check Report has been populated, use Ctrl+Q to create a Quick Report from the selected
account.
Customize Report Comment on Report Sha Memorize Print v | E-mail v | Excel » Hide Header Refresh
Dates Custom *  From 05/04/2020 B To |0T:’15.~’2020 (] | SortBy Default -
Show | Applied Filters
135 PM Castlerock Leasing, LLC.
B Account QuickReport
Accrual Basis As of July 15, 2020
Type Date Num Name Memo Split Amount Balance
Pinnacle Bank 22,084.84
3 Payment 05/04/2020 3954 Accounts Re.. 10,291.67 32,376.51 4
Bill Pmt -Check 05/04/2020 3182 Accounts Pa... -500.00 31,876.51
Bill Pmt -Check 05/04/2020 3183 Accounts Pa... -2,849.60 29,026.91
Bill Pmt -Check 05/04/2020 3184 Accounts Pa... -207.62 28,619.29
Check 05/04/2020 American Exp... -1.30 28,817.99
Check 05/05/2020 American Exp... -1,000.00 27,817.99
Check 05/068/2020 Onling Trans...  David - Draws -3,000.00 24,617.99
Check 051272020 Credit Cards -35.00 24,782 59
Payment 051372020 3987 Accounts Re.. 10,291.67 35,074.66
ACH ALE pcdated 03/30/202
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a. Select the Date drop-down menu to choose a specific date or date range for the transactions to
display in the report. Based on the range that is selected, check items that can be displayed can be
for a specific date, a specific quarter, month or even a date range that the user selects.

Customize Report Comment on Report Share Ter Memorize Print * Email * Excel = Hide Header Refresh
Dates LS Fiscal Year * From 01/01/2020 E To 12/31/2020 B SortBy Default -
Show | This Week -
p— This Week-to-date :
o;n gy TS Month Castlerock Leiasmg, LLC.
This Month-to-date Account QuickReport
Accrua
This Fiscal Quarter As of December 31, 2020
Type Date Num Name Memo Split Amount Balance

This Fiscal Quarter-to-date

nnacle Bank 24,288.87
This Fiscal Year
Check 01/01/2020 -SPLIT- -18,212.25 5,076.52 4

This Fiscal Year-to-Last Month

This Fiscal Year-to-date

Check 01/02/2020 -SPLIT- -2,037.18 4,030.44

Payment 01/03/2020 3807 Accounts Re 10,291.67 1433111
Yesterday Bill Pmt -Check 01/03/2020 3138 Accounts Pa... -2,349.60 11,481.51
Last Week Bill Pt -Check 01/03/2020 337 Accounts Pa... -227.96 11,253.55
Last Week-to-date Bill Pmt -Check 01/03/2020 3138 Mowing 201...  Accounts Pa... -595.00 10,658.55
Last Month Bill Pmt -Check 01/03/2020 3139 December2...  Accounts Pa... -365.00 10,293.55
Last Month-to-date Check 01/03/2020 American Exp. -19.44 1027411
Last Fiscal Quarter Check 01/06/2020 Online Trans... David - Draws -3,000.00 72741
AT e O AT e Check 01/06/2020 American Exp.. -1,000.00 62741
Last Fiscal Year Payment 01/08/2020  0092... Accounts Re... 15,041.67 2131578

Bill Pmt -Check 01/10/2020 3140 Accounts Pa... -260.00 21,05578
SRR Check 01/13/2020 Credit Cards -35.00 21,02078
fiextiicak y Check 0111472020 Credit Cards 529 21,014.49
Next 4 Weeks Check 01/14/2020 Credit Cards 6487 20,949.62

b. Click Customize Report button. The Modify Report screen displays. By using the Customize Report
feature, the user will be able to manage the amount of information contained in the report prior to
exporting the report to Excel. The user can select and/or remove items that are not needed in the
report.

Modify Report: Account QuickReport

Display Filters Header/Footer Fonts & Numbers

REPORT DATE RANGE

Dates ~ | The date range you specify in the From and To fields

From 05042020 @ To 07152020 @

REPORT BASIS

® Accrual 1 Cash This setting determines how this report calculates income and expenses.
COLUMNS
Search Columns . Sorthy Default -
vy @ Ascending order 2%
Sortin
 {left margin) = ~ Descending order 3%
Trans # '
< Type

Advanced...

Entered/Last Modified Put a check mark next ta each column

v that you want to appear in the report. Revert
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c. Click the Filters tab. In the listing of Filters, select Transaction Type. This will allow the user to remove
the transaction types that are needed for the check file.

Display Eilters Header/Footer Fonts & Mumbers
oo FIDER CURRENT FILTER CHOICES
Saarch Filters TransactionType FILTER ! SET TO
FLTER Account Pinnacle Bank
R - Multiple Transaclion Types
Ship Via Y Date Custom
+ Al
Template
Multiple Transaction Types
Terms
TransactionType
l Check
Vendaor Type
v Deposit
Invaice Remove Selected Filter
TRANSACTIONTYPE FILTER
Sales Receipt
Choose the type of transacti
select several transaction ty, P ayment
Transaction Types. Credit Memao
Journal
Credit Card
Bill Revert
CCard Credit
Bill Credit m Cancel Help
CCard Refund
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d. From the Transaction Type drop-down menu, select Multiple Transaction Types. This will allow the
user to select multiple check types within QuickBooks. For this example, we have used Check and
Bill Payment. Click OK to confirm the transaction types.

Display

CHOOSE FILTER FILTER CHOICES

Selectthe Transaction Types from the

Saarch Filterel list then click OK. b i S
FILTER CCard Credit & Pinnacle Bank
Shipvia | Bill Credit Custom
Template CCard Refund
Terms Bill Payment |'
TransactionTy | Bill CCard
Vendor Type Sales Tax Payment

¥

Remove Selected Filter

TRANSACTIONTY FE FILTER

Choose the type of transaction from the drop-down list. To
select several transaction types, choose Multiple
Transaction Types.

Tell me more...
Revert

an Alkami Solutio
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e. From the Modify Report screen, select OK to proceed. The requested changes to the report will

display.
Customize Report Comment on Report Memorize Print * E-mail * Excel - Hide Header Refresh
Dates Custom ~ From 05/04/2020 B To |D‘H1 512020 B] Sort By Default -

Show | Applied Filters

1:45 PM Castlerock Leasing, LLC.

Drgaan Account QuickReport

Accrual Basis As of July 15, 2020

Type Date Num Name Memo Split Amount Balance
Pinnacle Bank -2,513,174.63
» Bill Pmt -Check 05/04/2020 a2 Accounts Pa... -500.00 -2,51367453 4

Bill Pmit -Check 05/04/2020 3183 Accounts Pa... -2,849.50 -2,516,52423
Bill Pmt -Check 05/04/2020 3184 Accounts Pa... -207.82 -2,516,731.85
Check 05/04/2020 American Exp... -1.30 -2,518,733.15
Check 05/05/2020 American Exp... -1,000.00 -2,517,733.15
Check 05/06/2020 Online Trane...  David - Draws -3,000.00 -2,520,733.15
Check 051212020 Credit Cards -35.00 -2,520,768.15
Check 051372020 Credit Cards -45.08 -2,520,813.24
Check 05/14/2020 American Exp... -5,000.00 -2,525813.24
Check 05/14/2020 Credit Cards -1,610.44 -2,527 42358
Check 051472020 Credit Cards -25.00 -2,527 44888
Bill Pmt -Check 051812020 3185 Accounts Pa... 61591 -2,528,064.59

f. From the QuickBooks toolbar, click the Excel drop-down menu and select Create New Worksheet.

Customize Report

Comment on Report

Memorize Print |* | E-mail v | Excel ~ Hide Header Refresh

Dates Customn

~ From|psi052020 B | To 07/15/2020 B Sort By Defautt Mt SIS

Update Existing Worksheet

Show | Applied Filters

1:24 PM Castlerock Leasing, LLC.
L Account QuickReport
Accrual Basis As of July 15, 2020
Type Date Num Name Memo Split Amount
Pinnacle Bank
» Check 05/05/2020 American Express American Exp... -1,000.00
ACH ALE
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g. The Send Report to Excel pop-up window appears. Select Create New Worksheet > In New
Worksheet and click the Export button to continue.

Customize Report Comment on Report Share Template Memorize Print v | E-mail v | Excel ~ Hide Header Refresh
Dates  Custom ~  From |[05/05/2020 8| To 071152020 B Sort By Default X
Show | Applied Filters
124 PM Castlerock Leasing, LLC.
e Account QuickReport
Accrual Basis 2
Type
Hesaeie e WHAT WOULD YOU LIKE TO DO WITH THIS REPORT?
» Check
Check 0
Check in new workbook
Check g 7 in existing workbook
Check 0
Check 7 Update an existing worksheet How it works
Check 0 ' Replace an existing worksheet
Sl Pt Check g ) Create a comma separated values (.csv) file
Bill Pmt -Check
Bill Pmt -Check 0
Bill Pmt -Check
Bill Pmt -Check 0
Bill Pmt -Check 0
Bill Pmt -Check Advanced...
Check 0
Check 0
Check | Export | Cancel Help
Check - TTETIC AT R AT —r

h. Excel will open and the Excel file will populate. Within the Excel file, remove all rows that are blank
under the column header “Num”. By removing these items from the check file, items that do not have
a serial number assigned to them will not be uploaded into the PRO-CHEX System.

AutoSave (@ off) £ Search -

File Home Insert Page Layout Formulas Data Review View Help Acrobat QuickBooks
ﬁﬁ 4 Calibri {1 A A | === & | BWapTe Text v =] @ E/ =
Paste i B I U e e e === Mer B CAaT $ -9 . &0 .00 Conditional Formatas Cell Inzert]
- : = — = 9 0 A2l Formatting ~ Table~ Styles ~ -
Clipboard ] Font ] Alignment ] MNumber ] Styles
Al x: e
A B clo| E |Fl & [|H| 1 |J K [t M N a P Q
1 I Type Date Num Name i Memo Split Amount
2 Pinnacle Bank !
| | oupmt-check osoezoz ez [ Accounts Payable _500.00

Version 2.0.7 rev 4
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AutaSave : e Book2 - Excel £ Search
File Home Insert Page Layout Formulas Data Review View Help Acrobat QuickBooks
Cut o o —
I—f.lj 4 cu Calibri 1w AT A === &~ 28, Wrap Text General v ﬁ @ Normal
E@ Copy ~ 2
Paste Vi Mo A == . . 0 «0 .00 Conditional Formatas |Calculation
~ < Format Painter - = - - = paoatanisy $ % 9 % Farmatting ~ Table ~
Clipboard ] Font ] Alignment ] Mumber ]
016 i fe
A B ciB| E | F| G |H| 1T | ¥ K | E] W N (0] B Q |R] :
1 Type Date Num Name | Memo Split Amount 1
2 Pinnacle Bank ! i
1 r | T
3 Bill Pmt -Check 05/01/2020 0001 Eastside Utility District | Accounts Payable -23474 |
r 5 |
4 Check 05/15/2020 oooz Citibuziness Platinum H Credit Cards -13.26
S r i t
5 Check 05/16/2020 o0oo3 American Express ! American Express Business Gold -3 70118
& Check 06/16/2020 '0004 Lowes 1 Credit Cards -4,833.02
S r i t
T Check 07/01/2020 0005 Pinnacle Bank (v} | -SPLIT- -3,85324 |
r 5 |
8 Bill Pmt -Check 07/02/2020 0005 Eastside Utility District 1 Accounts Payable -143.18
i r | !
9 Check 0711472020 ooo7 Citibuziness Platinum | Credit Cards -1418.38 |
r 5 |
10 Check 071472020 o008 Lowes 1 Credit Cards -3,12860 |
11 Total Pinnacle Bank -17,42361 |
12_ TOTAL ! 1742361 |
13 |
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j- Select File > Save As and save the workbook.
i. Choose the File Name.

ii. Choose the Format. The file format for this file must be Comma Separated, Excel 97-2003

Workbook or Excel Workbook.

a Save As
<« v > ThisPC » Documents » New folder (2) v (] D Search Mew folder (2)
Organize v Mew folder S (7]
B This PC 2 MName . Date modified Type Size
. _J§ 3D Objects !@ Check File 0715202002 xlsx Microsoft Bxcel W... 22 KB
I Desktop !@ CheckFileTest.xlsx Microsoft Excel W... 12 KB
j Documents
“ Downloads
J" Music
&= Pictures
B Videos
ta 05(C)
== ACH Alert Share
£k Network v
File name: | CheckFileQBTesting)xlsx
Save as type: | Excel Workbook (*.xlsx)
Authors:  Tiffinay Farner Tags: Add a tag Title:  Add a title
[ Save Thumbnail
 Hide Folders Tools ~ Cancel

k. Click Save and close the workbook.
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4. Sign into the ACH Alert Client Portal.

Login
Username

Password

Forgot Password?

5. Select the PRO-CHEX Service Module.

Dashboard A& Manage Users  JliReports » = Transaction View change Module ~
BIO-WIRE
BIO-WIRE COPS. I
PDXACH
Total Wire Activity $0.00 ©@  Pending Wires $0.00 FROSTECHGR
PDX
Approved List Exceptions $0.00 [ 0] PRO-TECH

6. From the PRO-CHEX module, select Manage > Issue Templates to create an issue template. This will
allow the user to map the exported information from QuickBooks so that the file is read correctly when
uploaded to PRO-CHEX. The user will also be able to save this template for use in future issuance file

uploads.
PRO-CHEX ¥ Manage ~ # Perform ~ i Reports ~ E View ~ Change Module ~
[ Issue Templates | =
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7. The Issuance File Templates page displays. This page lists the saved Issue File Templates available for
the Client to use and allows the user to create a new template for use. Select Create New Template.

PRO-CHEX  #¥manage - # Perform - ol Reports -

o gl Create New Template
Template File Type
Delete Filter by Template Filter by File Type

Edit/View
1911 PROD Pipe Separated &
7-6-2020 Issue File Test Excel Workbook [
8. The Create New Template screen appears.
Create New Template
Template Mame File Type’ Template Status
- select file type b Active W
Number of Header Rows’ Mumber of Footer rows’ Template Level®
0 o Client W
Multi-Line Payee Name Separator: ’
Do not use & character as a separator if
that character will ever be presentina
Payee Name. Allowed characters in
brackets [ | . -_/]
This Client has not been setup for client additional issue fields in tempiates,
Configure in Client level settings and setup dient additional issue fields for the Client and try again.
File Mapping
Add  Input Field’ File Column’ Field Format
Serial Number
Amount’ @ Fractional Dollars {12.34)
) Whole numbers of cents (1254)
Status’ 15SUED - for ISSUED
VOIDED - for VOIDED
O ccount Number”
O Issuance Date’
O Payee Mame’
O Routing Number’
Save *- Place the cursor over this label for more information
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9. Creating the Issuance Template to the Exported Information from QuickBooks:

a. Template Name

Create a name for the template using information that will allow the user to easily identify this
template in the future. For this example, the template name is QuickBooks Export Type 1.

Template Name File Type’ Template Status
QuickBooks Export Type 1 - select file type b Active b
b. File Type

Select the appropriate file type based on the file type used to save the Excel document. For this
example, the file type will be Excel Workbook.

Template Name File Type’ Template Status
QuickBooks Export Type 1 Excel 97-2003 Workbook A Active v
! - select file type :
Number of Header Rows’ Comma Separated Template Level*
o Excel 97-2003 Workbook Ehient -
Excel Workbook
Fixed Width

Multi-Line Payee Name Separator: ’ i
Pipe Separated

Semi-colon Separated
Tab Separated

c. Template Status

The Template Status drop-down menu defaults to Active status. Leave the status as Active.

Template Name File Type’ Template Status

QuickBooks Expart Type 1 Excel Workbook hd Active |

7 ? _
Number of Header Rows Number of Footer rows Thactive
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d. Number of Header Rows

Refer to the Excel file that was created. A Header Row will be any row above the check information
that does not contain actual check information for presentment in the PRO-CHEX Module. For this
example, the header rows have been highlighted yellow. The number of header rows should be 2 in

the template.

A B cip E G H| | K L ! O P Q A

1 . [ Type Date i’ “Num i Name Memo Split i Amount .
il Pinnacle Bank

3 | Bill Pmt -Check 07/24/2020 '0100 Eastside Utility District Accounts Payable -234.74
4 | Check 07/24/2020 '0101 Citibusiness Platinum Credit Cards -13.26
o | Check 07/24/2020 '0102 American Express American Express Business Gold -3,701.19
B | Check 0712412020 '0103 Lowes Credit Cards -49833.02
£l Check 07/24/2020 '0104 Pinnacle Bank (v} -SPLIT- -3,853.24
8 | Bill Pmt -Check 072412020 '0105 Eastside Utility District Accounts Payable -143.18
g | Check 07/24/2020 '0105 Citibusiness Platinum Credit Cards -1,416.38
10 Check 072402020 'D1UF Lowes Credit Cards -3,128.60
1 Total Pinnacle Bank . -17 423 51
12 |ToTAL -17,423.61

e. Number of Footer Rows

Refer to the Excel file that was created. A Footer Row will be any row below the check information
that does not contain actual check information for presentment in the PRO-CHEX Module. For this
example, the footer rows have been highlighted yellow. The number of footer rows should be 2 in the

template.
A B | €D E G =1 | & K L M N Q P Q

1 ] . . T\:rpe D;ate . IN|.|=m N&ﬁe Mem.o [ ] Split 11 Amoﬁm
2 Pinnacle Bank

3 | Bill Pmt -Check 07/24/2020 ooo Eastside Utility District Accounts Payable -234.74
4 | Check 07/24/2020 '0101 Citibusiness Platinum Credit Cards -13.26|
5 | Check 07/24/2020 '0102 American Express American Express Business Gold -3,701.19
6 | Check 07/24/2020 '0103 Lowes Credit Cards -4,933.02]
T | Check 07/24/2020 'uwa Pinnacle Bank (v} -SPLIT- -3,853.24]
8 | Bill Pmt -Check 0772412020 VD1DE Eastside Utility District Accounts Payable -143.18]
9 | Check 0712472020 VD1DG Citibusiness Platinum Credit Cards -1,416.38)
10 | Check 07242020 107 Lowes Credit Cards -3,128.60
1 Total Finnacle Bank 1742361
12 _TOTAL -17,423.61
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f. Template Level

The default value of Client will be presented and will not allow a different selection to be made.

g. Multi-Line Payee Name Separator.

This feature is not currently available for items exported out of QuickBooks.

Template Name File Type’ Template Status

QuickBooks Export Type 1 Excel Workbook v Active hd
Number of Header Rows’ Number of Footer rows’ Template Level’

2 2 Client v

Multi-Line Payee Name Separator:

h. File Mapping
i. Serial Number
1. Enter the column number that the check number/serial number is presented in the Excel

document. For this example, the Num column is highlighted yellow. The column number for
Num should be 9 in the template.

_A_ B _C_D_ E _F_ G _H_ | _J K L_ M _N_ (o] _F'_ Q _F

1 | Type Date nl.lu=m Name Memo Split Amount
) Pinnacle Bank

3 | Bill Pmt -Check 07/24/2020 '01 0o Eastside Utility District Accounts Payable -234.74
4 Check 07/24/2020 '01 01 Citibusiness Platinum Credit Cards -13.28
5 | Check 07/24/2020 '01 0z American Express American Express Business Gold -3,701.1%9
6 Check 07/24/2020 '01 03 Lowes Credit Cards -4,533.02
Fi | Check 0T/24/2020 '01 04 Pinnacle Bank (v} -SPLT- -3,8653.24
8 Bill Pmt -Check 0712412020 '01 05 Eastside Utility District Accounts Payable -143.18
g | | Check 07/24/2020 '01 05 Citibusiness Platinum Credit Cards -1,416.38
10 | Check 07/24/2020 '01 07 Lowes Credit Cards -3,128.60
11 | Total Pinnacle Bank -17,423.61
12 |ToTAL [ -17,423.61
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ii. Amount

1. Enter the column number that the amount is presented in the Excel document. Select
fractional dollars if the dollars and cents are separated by a decimal. If the dollars and cents
are not separated by a decimal, select whole numbers of cents. For this example, the Amount
column is highlighted yellow. The column number for Amount should be 17 in the template.

A B ClB E E G Hf & |2 K L % M 0 P Q

1 [ | [ 1] Type || Date - =I"|I=ur'.r1= . Name . Memo . Split [ 1 Amount |
2 | Pinnacle Bank

3 | Bill Pmt -Check 072412020 '01 0o Eastside Utility District Accounts Payable -234.74
4 | Check 07/24/2020 '01 01 Ciibusiness Platinum Credit Cards -13.26
5 | Check 07/24/2020 '01 02 American Express American Express Business Gold -3.701.19
6 | Check 07/24/2020 '0103 Lowes Credit Cards. -4,833.02
Fi | Check OT/24/2020 '01 04 Pinnacle Bank (v} -SPLIT- -3,853.24
8 | Bill Pmt -Check 07/24/2020 '01 05 Eastside Utility District Accounts Payable -143.18
g | Check 07/24/2020 701 08 Citibusiness Platinum Credit Cards -1,416.38
10 | Check 07/24/2020 '010?' Lowes Credit Cards -3,128.60
11 Total Pinnacle Bank . 17,423 .61
12 ETOTAL | -17,423.61

iii. Status

1. Remove the checkmark from this box. The export from QuickBooks does not contain this
information. The user can add this information manually if they choose to. If the column is
added, the box will need to remain checked and the column number will need to be entered
for the PRO-CHEX system to accurately read it. For this example, the Status field is not being

used.
File Mapping
Add  Input Field’ File Column’ Field Format
Serial Mumber &
Amount’ 17 = @ Fractional Dollars (12.34)
T Whole numbers of cents (1234)
) Status’ [0 Treat Negative Amount As Void®

Issuance with $0 amount will be treated as Void

If the Status box is unchecked, the user should be aware that any issuance loaded with
negative amounts or a $0 amount will be treated as Void.
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iv. Account Number

1. The exported information from QuickBooks does not include an account number. Leave the
box unchecked and the File Column field blank. For this example, the Account Number field is
left blank.

O Status’ [ Treat Negative Amount As Void®

O Account Number?

v. Issuance Date

1. The Issuance Date is located in the “Date” column in the Excel document. The user must
check the box and enter the column number for the system to read the issuance date
correctly. For this example, the Date column is highlighted yellow. The column number for
Issuance Date should be 7 in the template.

| B €1 B E F G | K E vl (] Q

1 | [ 1| Type ] Date . Num . Name Memo Split . Am.o.i.lnt .
2| Pinnacle Bank

3 | Bill Pmt -Check 07/24/2020 ’EI1 0o Eastside Utility District Accounts Payable -234.74
4 | Check 07242020 'EI1 01 Citibusiness Platinum Credit Cards -13.28
4 | Check 0712412020 'EI1 02 American Express American Express Business Gold -3,701.19
B | Check 07/24/2020 'EI1 03 Lowes Credit Cards -4 833.02
7| Check 07/24/2020 ’01 04 Pinnacle Bank (v) -SPLT- -3,853.24
8 | Bill Pmit -Check 07/24/2020 '01 05 Eastside Utility District Accounts Payable -143.18
2 | Check 072472020 'EI1 05 Citibusiness Platinum Credit Cards -1,416.38
10 Check 072412020 ’01 07 Lowes Credit Cards -3,128.60
11 - Total Pinnacle Bank | -17 42381
12 |TOTAL -17,423.61
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vi. Payee Name

1. If the Client is set up to use Payee Positive Pay, the user will need to select the box and enter
the column number for the column labeled “Name” in the Excel report. For this example, the
Name column is highlighted yellow. The column number for Payee Name should be 11 in the

template.
A B ;C D E F G H| 1 |3 K E M M (0] P Q A
1 | Type Date Num Name Memo Split Amount
2 | Pinnacle Bank
| r
= | Bill Pmt -Check 07i24i2020 0100 Eastside Utility District Accounts Payable -234.74
4 | Check 072472020 '0101 Citibusiness Platinum Credit Cards -13.26
5 | Check 071242020 '0'102 American Exprezs American Express Business Gold -3,701.19
3 | Check 072412020 '0103 Lowes Credit Cards -4,933.02
i | Check 07242020 '0104 Pinnacle Bank (v} -SPLIT- -3,653.24
8 | Bill Pmt -Check 072472020 '01 05 Eastzide Utility District Accounts Payable -143.18
g | Check 07/24/2020 '0106 Citibusiness Platinum Credit Cards -1,416.38
10 Check 072412020 '0107 Lowes Credit Cards -3,128.60
11 Total Pinnacle Bank -17,423.61
12_ | TOTAL | -17,423.61
i. Click the Save button. A success message appears, and the user will be returned to the Issuance
Templates page. The new issue template will display in the list of templates.
Create New Template
Template File Type
Delete Filter by Template Filter by File Type Edit/View
csv Comma Separated ®
sV Comma Separated &
DEBFI Fixed Width Fixed Width @
Excel 97-2003 Workbook Excel 97-2003 Workbook @
O CPP1029 Test Excel Workbook r
B QuickBooks Export Type 1 Excel Workbook y
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B. Exporting from QuickBook Reports

1. From QuickBooks, select Reports on the Tool Bar.

— File Edit View Lists Favorites Company Customers Vendors

& [ncome Tracker

S Bill Tracker
Calendar

B Snapshots

B My shortc...
B view Balanc...
M Run Favorite Reports

B Open Windo...

ACH AI.EI‘I'

an Alkami Solution Team

cker Calendar

Home Page

Snapshots

Insights

Customers

Employees Banking

@

Enter Bills

=

5

Create
Invoices

Stateme.

Reports

Window Help Special Offers

Eeport Center
Memorized Reports
Scheduled Reports

Commented Reports

Company Snapshot

Process Multiple Reports

Company & Financial
Customers & Receivables

Sales

Jobs, Time & Mileage

Vendors & Payables
Employees & Payroll
Banking

Accountant & Taxes

Budgets

List

Contributed Reports
Advanced Reports

Custom Reports

Transaction History
Transaction Journal

e e

»
b
»
b
»
b
b
b
b
b
2
»
»
&
' Re
Pay
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2.

Select Banking from the drop-down menu and click Check Detail from the Banking sub-menu.

Report Center

pshots  Customers Memarized Reports 4
s Scheduled Reports 3
LR Commented Reports
Company Snapshot
My Shortcuts Py £ s
Process Multiple Reports
Company & Financial ¥
. @ Customers & Receivables ¥ % %
‘ﬁ My Company Sales »
Enter Bills e Pay Bills Mew: Business
Jobs, Time & Mileage > Loans
Income Tracke Vendors & Payables b
_— Employees & Payroll ¥
i Accountant & Taxes ld Check Detail
i calendar —
Budgets ¥ Missing Checks
t ol List 4 Bec?nmhahon D|ls.crs..-panc:y
Contributed Reports Previous Reconciliation
A My Shortc... Advanced Reports %
B View Balanc... Create Custom Reports | Receive
MM Run Favorite Reports iavoices Fayments
B open Windo... E] Transaction History @
Transaction Journal
Statemeu. Nt N Refund
3. The Check Detail Report will display.
Customize Report Comment on Report Sha Memorize Print | v | E-mail || Excel | Hide Header Refresh
Dates ~ | From 05/04/2020 B To 07/10/2020 B8 SortBy Default -
Show | Applied Filters
5:19 PM Castlerock Leasing, LLC.
grag Check Detail
May 4 through July 10, 2020
Type Num Date Name Item Account Paid Amount Original Amount
Check 05/04/2020 American Expre... Pinnacle Bank -1.30
American Express -1.30 1.30
TOTAL -1.30 1.30
P Check 05/05/2020 American Expre... Pinnacle Bank -1,000.00 4
American Express... -1,000.00 1,000.00
TOTAL -1,000.00 1,000.00
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a. Select the Date drop-down menu to choose a specific date or date range for the check items to
display in the report. Based on the range that is selected, check items that can be displayed can be
for a specific date, a specific quarter, month or even a date range that the user selects.

Customize Report Comment on Report Share Template Memorize Print v E-mail ¥ | Excel - Hide Header Refresh

Dates [SE - From 050042020 B To 07/10/2020 [ SortBy Default -

'y

Show | This Fiscal Quarter
This Fiscal Quarter-to-date

5:19 PN SN Castlerock Leasing, LLC.

o7 i
This Fiscal Year-to-Last Month Check Detail
May 4 through July 10, 2020

Num Date Name ltem Account Paid Amount Original Amount

This Fiscal Year-to-date

Yesterday

Last Week : 2
05/04/2020 American Expre... Pinnacle Bank -1.30

Last Week-to-date

Last Month American Express -1.30 1.30

-1.30 1.30

Last Month-to-date
Last Fiscal Quarter
Last Fiscal Quarter-to-date 05/05/2020  American Expre... Pinnacle Bank -1,000.00 4
LastFiscal Year

Last Fiscal Year-to-date American Express... -1,000.00 1,000.00
Mext Week -1,000.00 1,000.00

Mext 4 Weeks

05/06/2020 _ Pinnacle Bank ~3,000.00
Mext Month

Mext Fiscal Quarter David - Draws -3,000.00 3,000.00

-3,000.00 3,000.00

Mext Fiscal Year

v

b. Click Customize Report button. The Modify Report screen displays.

Modify Report: Check Detail

Display Filters Header/Footer Fonts & Mumbers
REPORT DATE RANGE

Dates ¥ | The date range you specify in the From and To fields

From 05/04/2020 E@ To 07/102020

COLUMNS

_éearch Columns Sortpy Default bl

o+ ® Ascending order
Sortin

BN NPB
o=

(left margin}
Trans #

< | Type
Entered/Last Modified
Last modified by

< |Date

< Mum

T Descending order

- >

Advanced...

Put a check mark next to each column
v that you want to appearin the report. Revert
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c. Select the Filters tab.

Maodify Report: Check Detail

Display Filters Header/Footer Fonts & Mumbers

CHOOSE FILTER CURRENT FILTER CHOICES

Search Filters Account FILTER ! SETTO

Account All bank accounts

ol All bank accounts -
Amount ==0.00
Include split detail?
Aging ' & iic Date Custom
Amount 6“. Yes TransactionType [Multiple Transaction T...

Billing Status ! For detail accounts matching

-

Class

Remove Selected Filter
ACCOUNT FILTER

Choose the types of accounts or a specific account from the

drop-down list. Indicate whether or not you want split detail
to appearin the report (Balance Sheet accounts only).

Tell me more...
Revert

d. In the listing of Filters, select Account from the drop-down menu.

i. Select All Bank Accounts to pull all checks issued from all bank accounts for which the user has
QuickBooks access.

Modify Report: Check Detalil hail |«
Display Eilters Header/Footer Fonts & Mumbers Default
s 2t B B CURRENT FILTER CHOICES
Search Filters Account FILTER ! SETTO Bing, L
SRR Account All bank accounts atail
- |AJI bank accounts -
Arnaint == Nn w 10, 2
Account i
' All accounts
Aging l
Multiple accounts...
Amount
Billing Status
All balance sheet accounts
Class

v All assets

All current azssets
ACCOUNT FILTER

All bank accounts

Choose the types of accoun -
drop-down list. Indicate whe Al @ccounts receivable

to appear inthe report (Bala 4|l other current assets
All fixed assets

All other assets
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ii. Select a single Bank Account to pull checks issued from a single bank account.

Modify Report: Check Detail . |
Display Filters Header/Footer Fonts & Mumbers Default
EROOSERIIEN CURRENT FILTER CHOICES
Search Filters Account SET TO Bing, L
o Account Pinnacle Bank atail
— [F'innacle Bank -
A Arnnnnt =—n nn v 10. 7|
Account i
e All alp and sales tax
ging
Current assets and expenses
Amount
= All AR and AP
Billing Status
All non-posting accounts
Class
v Allowed for 1099s
ACCOUNT FILTER '
Pinnacle Bank Bank
Choose the types of accoun il ) Bank Bank
drop-down list. Indicate whe  MIENNILM Han T
to appearinthe report (Bala  Accounts Receivable Accounts Receivable
Loans Receivable Other Current Asset
Inventory Asset Other Current Asset
Undeposited Funds Other Current Asset

iii. Under Include Split Detail?, click the button next to “No”.

Maodify Report: Check Detail

Display Filters Header/Footer Fonts & Numbers

CHOOSE FILTER CURRENT FILTER CHOICES

Search Filters Account FILTER SET TO
FILTER Account Pinnacle Bank

= Pinnacle Bank -
Aot A Amount ==0.00

Include split detail?
Aging ' = 0 Date Custom
A 1 Yes Detail Level Summary only
Billing Status  For detail accounts matching TransactionType |Multiple Transaction T...
Class Al gccounts -
v

Remove Selected Filter
ACCOUNT FILTER

Choose the types of accounts or a specific account from the

drop-down list. Indicate whether or not you want split detail
to appear in the report (Balance Sheet accounts only).

Tell me more...
Revert
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iv. Under Current Filter Choices, select Detail Level, and then click the Remove Selected Filter

button.

Modify Report: Check Detail

Display Filters Header/Footer Fonis & Mumbers

CHOOSE FILTER

CURRENT FILTER CHOICES

Search Filters Detail Level

FILTER

Pinnacle Bank

: SET TO

==0.00
Custom

Summary only

Multiple Transaction T...

- = AN
| A
Customer Type
= & Summary only
Date = t
7 All except summa i

Detail Level P L Detall Level
Due Date ITransactionType
EnteredMaodified

b

DETAIL LEVEL FILTER

Remove Selected Filter

Choose whether to show or hide the detail lines for each
transaction. Choose "Summary only' to exclude detail lines.

Tell me more...

Cancel

Revert

Help

v. Select Transaction Type from the Filter menu. Select Multiple Transaction Types from the
Transaction Types submenu.

Modify Report: Check Detail

Display Filters HeaderFooter Fonts & Mumbers
CHOOSE FILTER
Search Filters TransactionType FILTER
FILTER . . Account
: z Multiple Transaction Types
Template A Amount
Terms Date
Multiple Tra
TransactionType
Vendor Type
l Check
Voided
v Deposit
Invoice

TRANSACTIONTYPE FILTER

Sales Receipt

Choose the type ofransacti
select several transaction ty)
Transaction Types.'

Payment
Credit Memo
Journal

Credit Card
Bill

CCard Credit
Bill Credit
CCard Refund

CURRENT FILTER CHOICES

T SETTO
Pinnacle Bank
==0.00

Custom

TransactionType |Multiple Transaction T...

Remove Selected Filter

Revert

Cancel Help
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vi. From the Select Transaction Type drop-down menu, select the check transactions to appear in
the Check File. For this example, Check and Bill Payment options were selected. Click OK to
confirm the transaction types.

Display

CHOOSE FILTER FILTER CHOICES

Selectthe Transaction Types from the

Search Filters| 18t then click OK. i BETTO
FILTER < Check -F'innacle Bank
Template Deposit ==0.00
Terms Invoice Custom

TransactionTy | Sales Receipt

Vendor Type Fayment
Yoided Credit Mema

Remove Selected Filter

TRANSACTIONTY FE FILTER

Choose the type of transaction from the drop-down list. To
select several transaction types, choose ‘Multiple
Transaction Types.”

Tell me more...
Revert

e. From the Modify Report screen, select OK to proceed. The requested changes to the report will
display. From the QuickBooks toolbar, click the Excel drop-down menu and select Create New
Worksheet.

Customize Report Comment on Report Share Template Memorize Print | Email + Excel = Hide Header Refresh

Dates Custom ~  From 510412020 | To 07/10/2020 I I e Create New Worksheet

Update Existing Worksheet

Show | Applied Filters

8:47 PM Castlerock Leasing, LLC.
e Check Detail
May 4 through July 10, 2020
Type Num Date Name Hem Account Paid Amount Original Amount
P Check 05/04/2020 American Expre... Pinnacle Bank -1.30 4
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f. The Send Report to Excel pop-up window appears. Select Create New Worksheet > In New
Worksheet and click the Export button to continue.

Customize Report Comment on Report Share Template Memorize Print ¥ E-mail ¥ Excel ¥ Hide Header Refresh

Dates Custom *  From |0204/2020 B8 0 - L2020 S nrt Bw [efa -
Send Report to Excel

Show | Applied Filters

7
8:47 PM WHAT WOULD ¥OU LIKE TO DO WITH THIS REPORT?

07/10/20

® in new workbook

Type Nu o - o Original Amount
T in existing workbook

» Check I Update an existing worksheet How it works o

7 Replace an existing worksheet

- 130

Create a comma separated values (.csv) file e

TOTAL 130

Check -1,000.00

1,000.00

2L Advanced... 1,000.00

Check -3,000.00

Cancel Help
uuuuuuuuuu S 3,000.00
TOTAL -3,000.00 3,000.00

g. Excel will open and the Excel file will populate. Within the Excel file, remove all rows that are blank
under the column headers “Type” and/or “Num”.

File w Insert Page Layout Formulas Data Review View Help Acrobat QuickBooks
[ D EE(O Calibri S AN === E 25, Wrap Text General - @ @ Ej @
' § B I U- G-A-| === 5 = Heacmes- | § o0 siaim [ CREs bR CF | b
Clipboard Font Mui Alignment (] Mumber N Styles
D15 L f
A B | €] D |E| E 15| H |+ 3 K| L L M | O] P | Q
1 ] Type Num Date Name tem | Account Paid Amount Original Amount
= |
4] i Check 'i.‘rm1 05/1312020 Citibusiness Platinum | Pinnacle Bank -45.09
4 ] Check 'L'IODE 06/04/2020 Pinnacle Bank (v} : Pinnacle Bank -3,751.35
5 i Check '0003 06/03/2020 American Express | Pinnacle Bank -39.00
i} | Check '00&4 06/15/2020 Citibusiness Platinum EPin nacle Bank -13.26
T ! Check T}DIDS 06/16/2020 American Express | Pinnacle Bank -3,701.19
8 i Check '0006 06/16/2020 American Airlines VISA Pinnacle Bank -233.01
9 d Check 'i.'HJID? 06/16/2020 Lowes | Pinnacle Bank -4.933.02
10_ Check 'L'IODB 0710112020 Pinnacle Bank (v} : Pinnacle Bank -3,863.24
1 1_ Check 'trDDE 07/06/2020  American Express | Pinnacle Bank -1,000.00
12 Bill Pmt -Check '0010 050472020 Eastside Utility District ;Pin nacle Bank -207.62
13- Bill Pmt -Check '0011 06/01/2020 Eastside Utility District : Pinnacle Bank -234.74
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h. Remove all blank columns.

AutoSave (4 Book2 - Excel £ Search -
File Home Insert Page Layout Formulas Data Review View Help Acrobat QuickBooks
flj & Calibri 11 AN === B 35, Wrap Text General - ﬁ @ Fj
Paste E@ - B T U ) A = it e o) &0 .00 Conditional Formatas Cell
. I Yo~ i o = = = | #=: 2= | |5} Merge & Center ~ $ ~ 9 9 | %10 Formattingv Tablev Styles
Clipboard ] Font M= Alignment ] Number M= Styles
110 = 5
A B C D | E | F | G H ]
1 Type Num Date Name Account Original Amount
2 -
2 _|Check 7]1]0-1 051372020 Citibusiness Platinum Pinnacle Bank -45.09
4 ] Check 7]1}0-2 06/01/2020 Pinnacle Bank (v} Pinnacle Bank -3,751.35
i 1 Check TIH]GS 06/03/2020 American Express Pinnacle Bank -39.00
6 _|Check TJ'DM 06/16/2020 Citibusiness Platinum Pinnacle Bank -13.26
7 ! Check 7]1]05 06/16/2020 American Express Pinnacle Bank -3,701.19
8 |Check 73006 06/16/2020 American Airlines VISA  Pinnacle Bank -233.1
9 |Check TIH]G? 06/6/2020 Lowes Pinnacle Bank -4,933.02
1{}l Check TJODE- 07/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,853.24 | .I
11_ |Check 7]1]1}9 07/06/2020 American Express Pinnacle Bank -1,000.00
12_IB'rII Pmt-Check TJ'MO 05/04/2020 Eastside Utility District Pinnacle Bank -207.62
13_ !B'rbl Pmt -Check 7]011 06/01/2020 Eastside Utility District Pinnacle Bank -234.74
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i. Select File > Save As and save the workbook.

i. Choose the File Name.

ii. Choose the Format. The file format for this file must be Comma Separated, Excel 97-2003
Workbook or Excel Workbook.

Save As b4
[ ]

« v » ThisPC » Documents > New folder (2) v (o) D Search Mew folder (2)

Organize v New folder =z w o

~ i F i
I This PC MName Date modified Type Size

J 3D Objects Me iterns match your search.
[ Desktop
=] Documents
’- Downloads
.h Music
[&] Pictures
B videos
ua 05({C)
m= ACH Alert Share

F Network v

File name: | Check Report 05012020 through 07102020.x1sx o

Save as type: | Excel Workbook (*.x|sx) ~

j.  After saving, close the Excel workbook.
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4. Sign into the ACH Alert Client Portal.

Login
Username

Password

Forgot Password?

5. Select the PRO-CHEX Service Module.

Dashboard & Manage Users  JiReports » = Transaction View change Module ~
BIO-WIRE
BIO-WIRE COPS. I
PDXACH
Total Wire Activity $0.00 ©@  Pending Wires $0.00 PROTECHICR
PDX
Approved List Exceptions $0.00 [ 0] PRO-TECH

6. From the PRO-CHEX module, select Manage > Issue Templates to create an issue template. This will
allow the user to map the exported information from QuickBooks so that the file is read correctly when
uploaded to PRO-CHEX. The user will also be able to save this template for use in future issuance file
uploads.

PRO-CHEX = fManage~ # Perform~  iReports ~  iEView ~ Change Module ~

[ 1ssue Templates |e—
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7. The Issuance File Templates page displays. This page lists the saved Issue File Templates available for
the Client to use and allows the user to create a new template for use. Select Create New Template.

PRO-CHEX  #manage ~ . pPerform ~  JiReports -

—> Create New Template
Template File Type
Delete Filter by Template Filter by File Type Edit/View

1911 PROD Pipe Separated ®

7-6-2020 Issue File Test Excel Workbook &

8. The Create New Template screen appears.

Create New Template

Template Mame File Type’ Template Status
- select file type A Active W

Mumber of Header Rows’ Number of Footer rows’ Template Level”
0 (H] Client b

Multi-Line Payee Name Separator: ’

Do nat use a character as a separator if
that character will ever be presentina
Payee Name. Allowed characters in
brackets[; | .-_/]

This Client has not been setup for client additional issue fields in templates,

Configure in Client level settings and setup dient additional issue fields for the Client and try again.
File Mapping
Add  Input Field” File Column’ Field Format
Serial Mumber

Amount’ @ Fractional Dollars (12.34)
Whaole numbers of cents (1234)

Status’ ISSLUED - for ISSUED
VOIDED - fior VOIDED
O Account Number’
O Issuance Date’
O Payes Mame’
O Routing Number’
Save ’- Place the cursor over this label for more information
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9. Creating the Issuance Template to the Exported Information from QuickBooks:

a. Template Name

Create a name for the template using information that will allow the user to easily identify this
template in the future. For this example, the template name is QuickBooks Export Type 2.

Template Name File Type’ Template Status
QuickBooks Export Type 2° - select file type g Active g
b. File Type

Select the appropriate file type based on the file type used to save the Excel document. For this
example, the file type will be Excel Workbook.

Template Name File Type’ Template Status
QuickBooks Export Type 2° L select file type v | Active hd
" - select file type .
Number of Header Rows’ Comma Separated Template Level’
0 Excel 97-2003 Workbook Client -
Excel Workbook
Multi-Line Payee Name Separator: ? Fixed Width

Pipe Separated
Semi-colon Separated
Tab Separated

c. Template Status

The Template Status drop-down menu defaults to Active status. Leave the status as Active.

Template Name File Type’ Template Status

QuickBooks Export Type 2° - select file type e | Active ¥

? ? _
Number of Header Rows Number of Footer rows Inactive
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d. Number of Header Rows

Refer to the Excel file that was created. A Header Row will be any row above the check information
that does not contain actual check information for presentment in the PRO-CHEX Module. For this
example, the header rows have been highlighted yellow. The number of header rows should be 2 in

the template.

A _ B _ c D E _ F |
1 Type Num Date Name Account Original Amount
2 y
2 _Check EH}IH 05/13/2020 Citibusiness Platinum Pinnacle Bank -45.09
4 _Check -TZH}DZ 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.35
5 _Check EH}DS 06032020 American Express Pinnacle Bank -39.00
& |Check TSH}M 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
T _Cheu:lr. 5-04}5 06/16/2020 American Express Pinnacle Bank -3,701.19
8 |Check T}D-I}E 06/16/2020 American Airlines VI53A  Pinnacle Bank -233.71
g _Cheu:k EH}I}? 06/M16/2020 Lowes Pinnacle Bank -4,933.02
10 _{Zheck T:H:H}E 0710172020 Pinnacle Bank (v) Pinnacle Bank -3,853.24
11 |Check jl:]-EI-IJfEl' 07062020 American Express Pinnacle Bank -1,000.00
12 |Bill Pmt -Check :7}010 05/04/2020 Eastside Utility District Pinnacle Bank -207.62
e. Number of Footer Rows
Refer to the Excel file that was created. A Footer Row will be any row below the check information
that does not contain actual check information for presentment in the PRO-CHEX Module. For this
example, the footer rows have been highlighted yellow. The number of footer rows should be 2 in the
template.
& VR, E : . E .
1 Type Num Date Name Account Criginal Amount
2 4
3 |Check _r{H}D1 056/13/2020 Citibusiness Platinum Pinnacle Bank -45.09
4 _Check ’{H}DZ 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.35
5 _Check _r'I}D-DB 060372020 American Express Pinnacle Bank -39.00
B _Check {Jﬂﬂsi 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
K _Check _rﬂ-D-DS 06/M16/2020 American Express Pinnacle Bank -3,701.19
8 |Check ’{H}Dﬁ 06/16/2020 American Airlines VI5A  Pinnacle Bank -233.71
g _Check _rﬂ-D-D? 06/16/2020 Lowes Pinnacle Bank -4,933.02
10 _Check ’{H}DB 0701/2020 Pinnacle Bank (v) Pinnacle Bank -3,8583.24
11 |Check r{H}D‘:'r 07/06/2020 American Express Pinnacle Bank -1,000.00
12 :Elill Pmt -Check "II'}D'H} 05/04/2020 Eastzide Utility District Pinnacle Bank -207.62
13 :EHII Pmt -Check _r'I}D'M 06/01/2020 Eastside Utility District Pinnacle Bank -234.74
14 |Bill Pmt -Check ’1}1}12 07/0212020 Eastside Utility District Pinnacle Bank -143.18
15 |
16 |Total -18,155.40
17
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f. Template Level

The default value of Client will be presented and will not allow a different selection to be made.

g. Multi-Line Payee Name Separator.

This feature is not currently available for items exported out of QuickBooks.

Temnplate Name

QuickBooks Export Type 2°

Number of Header Rows’

2

Multi-Line Payee Name Separator: °

File Type’

Excel Workbook

Number of Footer rows’

-
£

Template Status

Template Level’

Active b

Client v

h. File Mapping

i. Serial Number

1. Enter the column number that the check number/serial number is presented in the Excel
document. For this example, the Num column is highlighted yellow. The column number for
Amount should be 2 in the template.

A B K D E F

1 Type Num Date Name Account Original Amount
2 | 1

3 :Check fmm 05/13/2020 Citibusiness Platinum Pinnacle Bank -45.09
4 _Check 501}2 06/01/2020 Pinnacle Bank (v} Pinnacle Bank -3,751.35
) :Check ﬂ)ﬂrﬂﬂ- 060372020 American Express Pinnacle Bank -39.00
& _Check ’6&}4 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
T :Check EPDDB 06/16/2020 American Express Pinnacle Bank -3, 701.19
a .Check jI'r.:hvl.'lllllﬁ 06/16/2020 American Airlines VISA Pinnacle Bank -233.1
g :Check EﬁDﬂ-? 06/16/2020 Lowes Pinnacle Bank -4,933.02
10 _Check '{HJDB 0710172020 Pinnacle Bank (v) Pinnacle Bank -3,853.24
11 :Check 'DDEI'EI 07/06/2020 American Express Pinnacle Bank -1,0040.00
12 ;Eill Pmt -Check 5010 05/04/2020 Eastside Utility District Pinnacle Bank -207.62
13 fB'rII Pmt -Check f)m'! 06/01/2020 Eastside Utility District Pinnacle Bank -234.74
14 |Bill Pmt -Check 5012 0710212020 Eastside Utility District Pinnacle Bank -143.18
15

16 | Total -18,155.40
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ii. Amount

1. Enter the column number that the amount is presented in the Excel document. Select
fractional dollars if the dollars and cents are separated by a decimal. If the dollars and cents

are not separated by a decimal, select whole numbers of cents. For this example, the Amount

column is highlighted yellow. The column number for Amount should be 6 in the template.

A [ B C D E E
1 Type Num Date Name Account Original Amount
=i
| r
3 |Check | O 05M3/2020 Citibusiness Platinum Pinnacle Bank -45.09
r
4 |Check | D002 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.35
r
5 |Check | 0003 06/03/2020 American Express Pinnacle Bank -39.00
[ r
o |Check | D004 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
[ r
7 |Check | 0005 06/16/2020 American Express Pinnacle Bank -3,701.19
[ r
g8 |Check | D006 06M6/2020 American Airlines VISA Pinnacle Bank -233.71
[ r
8 |Check | 0007 06M16/2020 Lowes Pinnacle Bank -4,933.02
[ r
10 |Check | D008 070172020 Pinnacle Bank (v) Pinnacle Bank -3,853.24
r
11 [Check | 0009 07/06/2020 American Express Pinnacle Bank -1,000.00
[ r
12 |Bill Pmt -Check [0010 05/04/2020 Eastside Utility District Pinnacle Bank -207.62
r
13 |Bill Pmt -Check 0011 06/01/2020 Eastside Uility District Pinnacle Bank -23M.74
[ r
14 |Bill Pmt -Check 0012 0710212020 Eastside Utility District Pinnacle Bank -143.18
15 _
16 Total -18,155.40
iii. Status
1. Remove the checkmark from this box. The export from QuickBooks does not contain this
information. The user can add this information manually if they choose to. If the column is
added, the box will need to remain checked and the column number will need to be entered
for the PRO-CHEX system to accurately read it. For this example, the Status field is not being
used.
File Mapping
Add  Input Field’ File Column’ Field Format
Serial Mumber 5
Amount? 6 @ Fractional Daollars (12.34)
2 Whole numbers of cents (1234)
O Status? [ Treat Negative Amount As Void®

If the Status box is unchecked, the user should be aware that any issuance loaded with
negative amounts or a $0 amount will be treated as Void.
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iv. Account Number

1. The exported information from QuickBooks does not include an account number. Leave the
box unchecked and the File Column field blank. For this example, the Account Number field is
left blank.

Status’ [ Treat Negative Amount As Void®

Account Number?

v. Issuance Date

1. The Issuance Date is located in the “Date” column in the Excel document. The user must
check the box and enter the column number for the system to read the issuance date
correctly. For this example, the Date column is highlighted yellow. The column number for

Issuance Date should be 3 in the template.

A. | _B. C D E | F .
1 Type [ Num Date Name Account Original Amount
2 | '
3 _Check :}[HH 051312020 Citibusiness Platinum Pinnacle Bank -45.09
4 :Check :ZH}I}E 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.356
3 _Check :}[H}S 06/03/2020 American Express Pinnacle Bank -39.00
& :Check ?T}U{M 06/15/2020 Citibusiness Platinum Pinnacle Bank -13.26
[ _Check KJ{H}E 06/116/2020 American Express Pinnacle Bank -3,701.1%
a :Check HJ{H}E 061612020 American Airlines VISA Pinnacle Bank -233.71
g _Check I}[H}? 06/16/2020 Lowes Pinnacle Bank -4,933.02
10 :Check ?TZHZI-I}B 07i01/2020 Pinnacle Bank (v) Pinnacle Bank -3,853.24
11 |Check TJ{H}EP O07106/2020 American Express Pinnacle Bank -1,000.00
12 gEliII Pmt -Check :ZHZHD 05/04/2020 Eastside Utility District Pinnacle Bank -207.62
13 |Bill Pmt -Check I}I}H 06/01/2020 Eastside Utility District Pinnacle Bank -234.74
14 :EliII Pmt -Check :ZHZHE 0710212020 Eastside Utility District Pinnacle Bank -143.18
15 _
16 | Total 18,155.40
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vi. Payee Name

1. If the Client is set up to use Payee Positive Pay, the user will need to select the box and enter
the column number for the column labeled “Name” in the Excel report. For this example, the
Name column is highlighted yellow. The column number for Payee Name should be 4 in the

template.
A [ B C D E F

1 Type Nurm - Date Name Account . Original Amount
2 | |

3 ;Check KZH}IM 051372020 Citibusiness Platinum Pinnacle Bank -45.,09
4 C heck r{I-'IZI-IZI-E 06/01/2020 Pinnacle Bank (v) Pinnacle Bank -3,751.35
& %Check ﬂ}l}l}S 06/03/2020 American Express Pinnacle Bank -39.00
& fCheck ’Elﬂ-l}xi 061152020 Citibusiness Platinum Pinnacle Bank -13.26
T %Check ﬁ}{rﬂﬁ 06/16/2020 American Express Pinnacle Bank -3, 701.19
8 fChet:IL ’{I-'I}I}E 06/M16/2020 American Airlines VISA Pinnacle Bank -233.1M
] éCheck 5}0-0? 06M6/2020 Lowes Pinnacle Bank -4,933.02
10 _fChec:Ir. ’Elﬂ-l}E- 070112020 Pinnacle Bank (v) Pinnacle Bank -3,853.24
11 éCheck {}O-I}Er 07/06/2020 American Express Pinnacle Bank -1,000.00

i. Click the Save button. A success message appears, and the user will be returned to the Issuance
Templates page. The new issue template will display in the list of templates.

o
Template File Type
e [Fowriy e ] —
sV Comma Separated ®
sVl Comma Separated [
DBFI Fixed Width Fixed width @
Excel 97-2003 Workbook Excel 97-2003 Workbook [
(] CPP1029 Test Excel Workbook b
O QuickBooks Export Type 1 Excel Workbook v
O QuickBooks Export Type 2° Excel Workbook v

an Alkami Solution Team
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C. Loading the QuickBooks Issue File

1. From the PRO-CHEX Module, select Perform > Issue File Load.

PRO-CHEX £+ Manage ~ # Perform ~ Wi Reports - = View ~ Change Module ~

| 1ssue File Load | €—

Manual Issue Entry

Welcome

2. The Load Check Issuance File page appears.

Issue File Load

Template to Use With Issue File

- select template - - Create New Template

Select template that matches issue file format

3. Select the Template drop-down box to select from a list of existing templates. Select the appropriate
template. For this example, QuickBooks Export Type 2 will be used.

Issue File Load

Template to Use With Issue File

- select template - b Create New Template

- select template -

csv

SV

DBFI Fixed Width

Excel 37-2003 Workbook
CPP1028 Test

QuickBooks Export Type 1
QuickBooks Export Type 2°
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4. The template selected was created without the Account field enabled. A drop-down box will display so
that the appropriate account can be selected. Select from the list of accounts. For this example, ABC
Heating — xxxx1555 will be used.

Issue File Load

Template to Use With Issue File Account?
QuickBooks Export Type 1 v - not selected - v Create New Template
- not selected -
ABC Heating - »(xx5555
View Selected Template Client & 3rd - xoaoc1117

Select account and template that matches issue file format

5. The file upload interface will appear. Click the Browse button to select the appropriate file or drag and
drop the file into the box indicated on the interface screen.

Issue File Load

Template to Use With Issue File Account’

QuickBooks Export Type 1 v ABC Heating - 005555 v Create New Template

View Selected Template

Select one issue file that is in the format of the selected template

Select files... & Browse ...
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6. Once the file is selected, it will be displayed in the upload interface.

Issue File Load

Template to Use With Issue File Account’

QuickBooks Export Type 1 v ABC Heating - 0001555 v Create New Template

View Selected Template

Select one issue file that is in the format of the selected template

b

L+]
@
Elb
¥l

B CheckFileTestaxlsx M Remaove | @® Upload

7. Click the Upload button to proceed. Once the file has loaded successfully, the Issuance File Status page
will display and will be eligible for editing in the Issue Warehouse.

< Back to Status CheckFileTest.xlsx

File Status

Queued Processing Processed Approved Complete Deleted

File processing is complete. View list below to see items.

® View items: 12 Items totaling $18,155.40

Rows 1-120f12.
Account Number Serial Number Amount Payee Name Status Load Date Issuance Date
¥xxx1555 1 $45.09 Citibusiness Platinum AVAILABLE_FOR_MATCHING 07/22/2020 15:39:24 EDT 05/13/2020
¥xxx1555 2 $3.751.35 Pinnacle Bank (v) AVAILABLE_FOR_MATCHING 07/22/2020 15:39:24 EDT 06/01/2020
XXxx1555 3 $39.00  American Express AVAILABLE_FOR_MATCHING 07/22/2020 15:39:24 EDT 06/03/2020
*¥H¥x1555 4 £13.26  C(itibusiness Platinum AVAILABLE_FOR_MATCHING 07/22/2020 15:39:24 EDT 06/15/2020
061555 5 $3,701.19  American Express AVAILABLE FOR_MATCHING 07/22/2020 15:39:24 EDT 06/16/2020
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APPENDIX C — DOCUMENT REVISION INDEX

A comprehensive list of all revisions made to this document since last publication.

Previous Version: 2.0.7 rev 3 (published 03/09/2022)
Current Version: 2.0.7 rev 4 (published 03/30/2022)

Section Pages Description

Entire Document Miscellaneous screenshots updated to reflect minor
changes in user interface.

Section VlIl - Payee Positive Pay Tips | p. 78-83 B. Ideal Check Formatting — Complete overhaul of this
& Best Practices section to provide more detail on good and bad
examples of check formatting.

p. 84-85 C. Other Common Check Formatting Problems —
Much information previously included in this
subsection were covered in more detail in the previous
subsection and were therefore removed from this
subsection to prevent redundancy.

p. 85-91 D. Multiple Payee Handling — Updated to include
example graphics.
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